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Windows Cluster Environment Upgrade (5.2.0 -5.2.2)

You can upgrade the IBM® Sterling B2B Integrator software in a Windows cluster
(multiple node) environment.

Use this guide to upgrade in a Windows cluster (multiple node) environment.

Clustering is not supported for Sterling B2B Integrator systems that use the
MySQL database.

You should also review these documents:
* System Requirements

* Release Notes

* What's New

* Installation and Upgrade Information

It is important to remember that upgrading involves a full installation of Sterling
B2B Integrator. You need to prepare for an upgrade the same way that you would
prepare for an installation. It is also recommended that you thoroughly test this
process in a test or development environment prior to implementing in a
production environment.

This upgrade does not overwrite your current Sterling B2B Integrator directory
structure on disk. Instead, it creates a new installation of Sterling B2B Integrator
that points to and upgrade the database of your current installation of Sterling B2B
Integrator. This means your original instance will no longer be operational after
performing the upgrade. After the upgrade, you will be starting your Sterling B2B
Integrator instance only from the newly created directory structure.

For new installations, use the Sterling B2B Integrator Windows Cluster Installation
Guide.

Intended Audience

This document is intended for use by:
* System Administrators

* Installation Engineers

* Database Administrators.

Assumptions for this Guide

The procedures in this guide are accurate as of the publication date and are
specific to this version of the document.

Upgrade Scenarios

Upgrade Scenarios (Windows Cluster Environment)

Upgrading to Sterling B2B Integrator can follow one of these paths. Keep these
scenarios in mind as you plan for your upgrade:

© Copyright IBM Corp. 2000, 2014 1



Upgrade Scenario

Example

Operating system and the database are the
same between the old Sterling Gentran
Integration Suite version and this version of
Sterling B2B Integrator

If you are upgrading from Sterling Gentran
Integration Suite 4.3 (on Windows 2003
and using Microsoft SQL Server 2005) to
this version of Sterling B2B Integrator (on
Windows 2003 and using Microsoft SQL
Server 2005), the upgrade steps are as
follows:

* Export the configuration data.

* Back up the database.

* Upgrade to Sterling B2B Integrator.

Database upgrade before the upgrade to this
version of Sterling B2B Integrator when the
old Sterling Gentran Integration Suite
database is not supported by this version of
Sterling B2B Integrator

If you are upgrading from Sterling Gentran
Integration Suite 4.0 (on Windows 2003
and using DB2 8.1 Fixpack 5) to this
version of Sterling B2B Integrator (on
Windows 2003 and using DB2 9.2), the
upgrade steps are as follows:

* Export the configuration data.
* Back up the database.

 With help from a database administrator
(DBA), copy the database to DB2 9.2.

* Back up the newly created database.

* Upgrade by pointing to the newly
created database. If the upgrade stops,
and leaves the newly created database in
an incomplete state, you can re-start the
upgrade using the backup of the
database.

Your Sterling Gentran Integration Suite
operating system is not supported by this
version of Sterling B2B Integrator

If you are upgrading from Sterling Gentran
Integration Suite 4.0 (on Windows 2000
and using Oracle) to this version of
Sterling B2B Integrator (on Windows 2003
and using Oracle), the upgrade steps are as
follows:

* Export the configuration data.
* Back up the database.

» Upgrade to this version of Sterling B2B
Integrator on the RH EL 5.0 machine
while pointing to Oracle.

Moving your current Sterling B2B Integrator
(5.0 or higher) instance to a new operating
system

For example, if you are upgrading from
Sterling B2B Integrator 5.0 on Windows
Server 2003 to this version of Sterling B2B
Integrator on Windows Server 2008 using
your current database.

* Export the configuration data and back
up the database.

» Upgrade to this version of Sterling B2B
Integrator on the Windows Server 2008
machine while pointing at your current
database.

2 Windows Cluster Environment Upgrade:




Upgrade Impacts

Upgrade impacts overview

This documentation provides information about how system behavior changed
based on upgrading your system from 4.3 (or later) to this version. Review all of
the information before you begin your upgrade.

Upgrade impacts (version 5.2.0 - 5.2.2)

Before you begin an upgrade, review the following information.
Features/services not supported

The following features/services are no longer supported:

* Channels portlet

* Federated Systems

* Community Management (AFT Communities are still available)
* Sterling Community Management (SCM) Integration

* Archive Commandline Service

* Sync Engine Data Clean Manager Service

* Sync Engine Task Manager Service

If you need more information, contact your IBM sales representative.
Port allocation changes in 5.2.0

If you are upgrading to 5.2.0, and you configured the CLA2 or the SWIFTNet
HTTP Server adapter, the remote port numbers were changed for 5.2.0. The port
numbers are as follows:

Table 1. Remote Port Numbers

Adapter Name Version 5.2.0 Base Port Version 5.2.1 Base Port
CLA2 +51 +52
SWIFTNet HTTP Server +52 +53

Note: Check your adapter configurations and the sandbox.cfg file for ports greater
than 51 that were changed

For Version 4.3 and Version 5.0, the remote port numbers are the same as the 5.2.1
release.

After you upgrade to 5.2.0, you must change any references to the old remote port
numbers. For example, if you have any business processes that use the CLA2
adapter, you must update the remote ports in the business process.

Database table sizes
While you are upgrading, if you encounter any database table size issues,
manually adjust the database tables and restart the upgrade process. An upgrade

that uses the production database in a test environment can help you determine
what tables must be manually adjusted.

Windows Cluster Environment Upgrade (5.2.0 -5.22) 3



Resource tags

If you are using resource tags in your current version, check all of your existing
resource tags before you start the upgrade process. Check the following resource
tags:

 Adapter Policies

* Agreements

« Sterling Connect:Direct® Netmaps

* Proxy Servers

* Security Tokens

* SSH Resources

* SWIFTNet Copy Service Profiles

* SWIFTNet Service Profiles

You can check the resource tags by running the following SQL query from the SQL
Manager page (Operations > Support Tools):

SELECT * FROM TAG_RESOURCE_ASSOC WHERE TYPE=41 OR TYPE=42 OR TYPE=43 OR TYPE=44 OR
TYPE=45 OR TYPE=52 OR TYPE=53

The TAG_NAME column in the SQL results contains the names of any resource
tags that must be edited or deleted.

If any of the resource tags contain tagged resources that are using the types that
are listed, remove those resources from the resource tags or delete the resource tags
that contain these resource types.

Silent installation parameters

The following parameters are new or have an updated definition:

What changed

parameter Definition

changed

Parameter definition that | LICENSE_FILE_PATH (Required) Full path to Core_License.xml.

New parameter

LICENSE_FILE_# (where #is a | (Required) This parameter is required for each license
number 1 - 99) you install. You must add an entry for each license file
to the silent installation file. The LICENSE_FILE
numbering (#) does not need to be sequential.

For example:

LICENSE_FILE_1= SI_SFG_License.xml
LICENSE_FILE_2= Fin_Serv_License.xml
LICENSE_FILE_3= SI_SFG_FIPS_License.xml
LICENSE_FILE 4= AS2 License_.xml

LICENSE_FILE_5= EBICS_License_.xml

4  Windows Cluster Environment Upgrade:



Channels and community management tabs (optional)

The Dashboard PSML files are not updated during an upgrade. The PSML file
affects any custom tabs that you configured, such as Channels or Operator. The
Channels and Community Management tabs are displayed in your browser but are
no longer operational.

To remove the Channels and Community Management tabs:

Note: The psmlRestore command gets the 5200 PSML file, which resets all of the
custom tabs from the previous release.

1. Navigate to the installation directory.
2. Navigate to the bin directory.
3. Enter this command: ./psmlRestore.sh admin

Custom BI fact models must be upgraded

Scripts named recreateBITablePKs.cmd.in (Windows) and recreateBITablePKs.sh.in
(UNIX) are now provided to upgrade any custom BI fact models that are tied to a
separate BI repository.

BI fact models must be upgraded to continue to work with the Entity Framework,
which replaced Hibernate usage in the BI framework in version 5.2.0.

Backups not generated during installation, upgrade,
application of fix pack or interim fix

Before you begin an upgrade, review the following backup information.

Some of the standard resources that are installed during installation, upgrade, fix
pack, or interim fix use the import mechanism available to customers to load the
standard resources into the database. By default, the standard import mechanism
creates a backup of the table that contains the resource. The backup is created
before import to allow for restoration to the previous state if the import must be
undone. During the basic installation process this table backup is also created by
default. Since the import mechanism is often used multiple times during the
installation process, some of the tables are backed up multiple times. Depending
on the size of the table, multiple backups add a large amount of time to the
installation process. The default behavior was changed to not make the backup by
default. If you want these backups, then add SKIPIMPORTBACKUP=false to
sandbox.cfg file.

Capitalization insensitivity for header value
About this task

Before you begin an upgrade, review the following AS3 information.
For AS3, when you are searching for a header value in a multipart/report, do not
consider whether the header value contains any capitalization. The search was

enhanced to be capitalization insensitive.

For example, the following searches result in a match:
* Multipart/Report
* Multipart/report

Windows Cluster Environment Upgrade (5.2.0 -5.22) 5



* multipart/Report
* multipart/report

The search would not find the following as a match:
¢ MulTiPart/RePorT

CA certificates impacts

Before you upgrade, review the following information about CA certificates.

Users might add multiple copies of the same certificates to the database. Having
multiple copies of the same certificate in the database is not, in principle, a
problem for the system except for the minor amount of wasted storage. Each copy
has a different object ID in the database and is a separate database object.

The specific changes in this release are the ability to easily populate the product
database with the set of authority root certificates that are distributed with the
JVM.

Installing a perimeter server
About this task

Before you begin an upgrade, review the following perimeter server installation
information.

Silent installation is now the default installation mode. If you want to complete the
perimeter server installation with an interactive mode, you must use the following
command:

java -jar ps_4400.jar -interactive

Retry logic added to WebSphere MQ suite adapter PUT
service
About this task

Before you begin an upgrade, review the following WebSphere MQ Suite adapter
PUT Service information.

Retry logic was added to the WebSphere MQ Suite. To accommodate this new
functionality, you must configure two new parameters for the PUT service:

. wsmq_send_retryCount
* wsmgq_send_retrySleepInterval

To configure the new parameters:

Procedure

Log in to Sterling B2B Integrator.

From the Admin Console Home, start the Graphical Process Model (GPM).
Log in to the GPM. You need a User ID and Password.

In the GPM, select View > Stencil > Services.

Select File > New.

Drag the WebSphereMQ Suite Put Message Service from the All Services
pane into the center pane.

ook wNn =
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7. Double-click the WebSphereMQ Suite Put Message Service.
8. Select the configuration from the Config dropdown.
9. Enter the number of retries in to the wsmq_send_retryCount value.

10. Enter the sleep interval in seconds in to the wsmq_send_retrySleepInterval
value.

11. Save the changes to the service configuration.
12. Exit from the GPM.

Services and adapters - Show Advance State button

Before you begin an upgrade, review the following Show Advance State button
information.

The Show Advanced State check box was removed from the Services
Configuration search screen. Instead, the default was changed to always show the
advanced state without needing to check a check box on the search screen to
display it.

Optional certificate fields
About this task

Before you begin an upgrade, review the following certificate field information.

When you are generating certificate keys, the following fields might be missing in
the release from which you are upgrading, but the entries are now optional:
* altname.dns

¢ altname.IP

Support for multiple AS2 organizations

Before you begin an upgrade, review the following AS2 schema information.

Sterling B2B Integrator now supports multiple sponsoring organizations and
multiple partners for AS2. During upgrade, the single organization is flagged as
the default organization.

After you upgrade to this version, a prefix designation is used to differentiate
between an AS2 organization (AS2_ORG_) and an AS2 partner (AS2_PART_). Each
requires the full configuration of a trading partner to allow for a partner to trade
with multiple organizations, and an organization that trades with multiple
partners.

The AS2_TRADEPART_INFO and AS2_EMAIL_INFO tables were modified and the
AS2_PROFILE table is newly introduced. Updates to these tables occur during the
Sterling B2B Integrator in-place upgrade process in the following manner:

* Identify the default organization and populates the AS2_PROFILE table with
organization information. A default organization is an AS2 organization profile
named "profile. ORGANIZATION" present in the system before upgrade.

* Identify partner records and populates the AS2_PROFILE table with partner
information.

* Populate the new columns of table AS2_TRADEPART_INFO with the default
organization information.

* Populate the new PROFILE_ID column in the AS2_EMAIL_INFO table with the
profile id of the AS2 organization profile present in the system.

Windows Cluster Environment Upgrade (5.2.0 -5.2.2) 7



Web services

Before you begin an upgrade, review the following web services information.

Many of the web services configuration settings that were generated from the
WebServices Provider Configuration Ul moved from the property files into
database tables. The change was made to allow a single location of these settings
in cluster environments and to ensure that these settings would not be reset during
fix pack installation.

After you complete your upgrade, run the convertWSSoaProperties script found in
the installation bin folder. This script reads the settings from the property file and
places them into the appropriate database tables. You can then review the results
in the WebServices Provider Configuration UL

Windows 2003/2008 does not start with silent installation

About this task
Before you begin an upgrade, review the following silent installation information.

If you used the silent installation method for your upgrade, you must manually
run the InstallWindowsService.cmd file to register the service.

Upgrade Planning

Upgrade planning information

Before you begin an upgrade:

* Read and become familiar with this document to understand what the upgrade
requires.

* Review upgrade scenarios to determine which scenario you want to use.
* Review and record system configuration information.

* Review and record performance and tuning information.

Upgrade planning checklist

To assist you with your upgrade planning, review the following planning checklist:

Upgrade Planning Checklist

Your Notes

Read through this entire document so that you have a clear
understanding of what the upgrade requires.

Download and review the following information from the
Sterling B2B Integrator documentation library.

* System requirements - With each release, IBM introduces
leading-edge technology to improve and enhance its software.
Review the System requirements to confirm that your system
and databases meet the requirements for this release.

¢ Release notes - Review the release notes to obtain information
about issues and resolutions that are identified for this release.

e What's new in this release - Review to find out about new
features and functionality that is provided in this release.

* Installation and upgrade information - Lists the installation and
upgrade documents available for this version of Sterling B2B
Integrator.

8 Windows Cluster Environment Upgrade:




Upgrade Planning Checklist

Your Notes

Review the Customer Center Knowledgebase and search for any
additional information about upgrade issues.

CAUTION:

Before you upgrade to the latest product version, contact your
sales representative to verify that it includes all of your
current functionality. Depending on the timing, even though it
is in a higher version that the one you installed, a particular
mod release or fix pack might not include all the functionality
in your current version or fix pack.

Collect information about third-party libraries that are used for
adapter configurations that were added to your current release.

You must add each of these libraries to the upgraded system.

Locate any configuration file changes for JDBC adapter or
Lightweight JDBC adapter in your current release.

You must copy these changes to the upgraded system.

Record your performance tuning configuration.

You must restore these settings after the system is upgraded.

Review and note the adapters, business processes, and other
configurations in your current release.

This information helps you identify the need for updating
transport messages, third-party adapters, or configurations to
adapters, such as file system or command-line adapters.

Determine whether you edited any of the pre-defined business
processes.

If you are upgrading from 4.2 or if you are upgrading from 4.3
and are using the 5.0 GA or 5001 Media, the upgrade process
overwrites pre-defined business processes. Your customized
business processes are preserved in the system, but they are not
the default business process after the upgrade.

If you are upgrading from 4.3 and are using the 5002 Media or
later, customized business processes are preserved in the system
and remain as the default.

Determine whether you edited any of the property files
(.properties or .properties.in).

The upgrade process overwrites these property files, unless
these changes were made in the customer_overrides.properties
file. Your previous property file edits might not be applicable
this version of the software.

10

Determine whether you edited any of the following cdinterop
files:

» cdinterop-proxy-records.properties

* cdinterop-spoe-auth.properties

* cdinterop-spoe-policy.properties

* cdinterop-user-records.properties

You must back them up before you upgrade. The cdinterop files

do not have initialization (*.in) files. After the upgrade, use the
backup version of the files in your upgraded installation.

Windows Cluster Environment Upgrade (5.2.0 -5.2.2)
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Upgrade Planning Checklist

Your Notes

11

Determine whether you have LDAP (Lightweight Directory
Access Protocol) configuration information in the
security.properties file. This information is automatically
moved to the authentication_policy.properties file.

12

Determine whether Sterling B2B Integrator is using an
application server (JBoss", WebLogic®, or WebSphere®).

Sterling B2B Integrator does not require an application server for
installation or at run time.

Sterling B2B Integrator supports integration with JBoss and
WebLogic during the installation. You can also integrate with
WebSphere, JBoss, or WebLogic by using the Sterling B2B
Integrator EJB adapter (this does not represent a WebLogic
server for deploying the Application Console).

13

If you use a file system as your document storage method,
determine and record the path to the file system.

You will need the file system path structure so that after the
upgrade, you can copy/mount the documents to the new
installation directory. The directory structure (path to the file
system) must be the same in the current and in the upgraded
system.

14

Review the EDI Sequence Check Queue to ensure that no
interchanges are in the queue. The EDI Sequence Check Queue
is used for X12 and EDIFACT sequence and duplicate checking.

15

Determine whether you have any JVM Containers configured.

If yes, you must reconfigure the JVM containers after you
upgrade the software.

Supporting Information

Accessing the Sterling B2B Integrator knowledgebase

About this task

Before you upgrade, you might want to access the Sterling B2B Integrator
knowledgebase. The knowledgebase contains many topics and has a search engine

to assist you in finding information. To access the knowledgebase:

Procedure

1. Navigate to the Customer Center website.
Enter your User Name and Password.
Click Support Center.

o k0N

Enter search criteria and click Find.

10 Windows Cluster Environment Upgrade:
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Prepare Your Windows System for the Upgrade

Prepare your Windows system for the upgrade checklist

Use this checklist to prepare your windows systems for the upgrade.

Windows system for the upgrade checklist

Your notes

Complete the pre-upgrade system checklist.

Complete the pre-upgrade database checklist.

WIN |~ | #*

Download the correct version of the JDKs, JCE, and JDBC
drivers required. See the System requirements for information
about how to download the correct version of each.

Pre-upgrade system checklist
Before you begin an upgrade:

#

Pre-Upgrade System Checklist

Your Notes

1

Use the system requirements to verify that your
system hardware and software meet the
requirements that are specified for this release.

Verify that you have the correct:

* Patches required by Java™ for the operation
system

* Version of the JDK
* JDK Patches
* Absolute path to JDK and patches

¢ Database must match the version that is listed in
the requirements

If any of these requirements are not met, the
installation fails and prints/logs a report of all
items that were non-compliant.

Review your current system to determine whether
you must apply a fix pack before you upgrade.

If you recently applied an interim fix, the interim
fix might not be included in the latest fix pack. If
you are not on the latest fix pack, the upgrade
fails. The following are the minimum fix pack
levels for upgrading to this release:

* Release 4.0 - Fix pack 4.0.3-5
* Release 4.1 - base release or any fix pack
* Release 4.2 - base release or any fix pack

* Release 4.3 - base release or any fix pack

For systems with multiple IP addresses, verify that
the IP address on which Sterling B2B Integrator is

located is accessible by any client computer that is
running a browser interface.

If you do not verify the IP addresses, your system
might not operate properly after you install
Sterling B2B Integrator.

Windows Cluster Environment Upgrade (5.2.0 -5.2.2)

11



# Pre-Upgrade System Checklist Your Notes

If you are using a non-English environment,
confirm that you are using the appropriate
character set.

5 Verify that the file system has adequate free disk
space.
6 Obtain the upgrade and patch media.

Check the Product Updates & Downloads site to
ensure that you have the latest version of the
media.

7 Back up your Sterling B2B Integrator installation
directory and the database.

If there are problems with your upgraded system,
the only way to ensure that you can roll-back to
your previous version is to back up Sterling B2B
Integrator and the database.

8 Archive your data.

Archived data must be restored from the same
version and fix pack of Sterling B2B Integrator
from which it was archived. If you must restore
archived data that was archived before you
upgraded, then you must have a running instance
of Sterling B2B Integrator that matches the version
and fix pack from which the archive was taken.

9 Purge any unneeded data.

10 Export any business objects that cannot be
upgraded. Including business processes, service
configurations, trading partners, maps, and so on.

The exported business object can be imported into
the upgraded system if you need them.

11 Create a process output log.

12 Disable the virus protection software on the server.

If the virus protection software is enabled, the
upgrade fails.

Pre-upgrade database checklist (cluster environment)

Before you begin an installation:

Pre-upgrade database checklist (cluster
# environment) Your notes:

If required, copy the Microsoft SQL Server 2000
database to an SQL Server 2005 database.

This procedure is optional and it is the customer's
responsibility to perform it. IBM Customer
Support cannot help with this procedure.)

2 If you are using Oracle 8i with Sterling B2B
Integrator 4.0, upgrade to Oracle 9i before you
upgrade to this version of Sterling B2B Integrator.

12  Windows Cluster Environment Upgrade:



Pre-upgrade database checklist (cluster
environment)

Your notes:

If you plan to import an Oracle 9 or Oracle 10
database when you upgrade to this version of
Sterling B2B Integrator, you must import the
database without the indexes.

For example, if you are using the Oracle import
(imp) tool, use the INDEXES=N option. If you
attempt upgrading to this version of Sterling B2B
Integrator with indexes turned on, the upgrade
fails. If you created any custom indexes in Oracle
database, add them after you upgrade as they are
not imported.

If you are using MySQL, a new MySQL database is
created in this version of Sterling B2B Integrator
and information is copied from the MySQL
database in your previous version of Sterling B2B
Integrator to the new database.

The MySQL database in your previous version of
Sterling B2B Integrator works. When you copy
your database, if you encounter Data Overflow or
Invalid Time Format errors while you are copying
the WORKFLOW_CONTEXT table, run this query:

UPDATE WORKFLOW_CONTEXT SET ENTERQ = NULL,
EXITQ = NULL where ENTERQ IS NOT NULL OR EXITQ
IS NOT NULL

Supporting Information

Verifying that your system meets the system requirements

Before you begin the installation, verify that your system meets the hardware and

software requirements that are specified for this release. The hardware
requirements that are listed in the System Requirements are the minimum that is

required. Your system requirements exceed the minimum if you are running other
applications on the same system as Sterling B2B Integrator.

The installation strictly enforces the following system requirements:

If any of these requirements are not met, the installation fails. If the installation

JDK version must match requirement exactly.

Database version must match exactly.

Operating system version must match requirement exactly.

The minimum fix pack level for the operating system is enforced, but you can
apply higher fix pack levels.

JDBC driver version supports exact matches and wildcard matches.

fails, review the installation log for a list of non-compliant items.

Windows Cluster Environment Upgrade (5.2.0 -5.2.2)

The disk space is a minimum for the installation. The system must be separately
sized to handle whatever load is going to be put on the system.
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Obtaining upgrade media
About this task

Before you upgrade, check the Product Updates & Downloads site to ensure that
you have the latest version of the upgrade media.

To obtain the most recent version of upgrade media:

Procedure

1. Go to https://customer.sterlingcommerce.com.

2. Enter your User Name and Password.

3. Click Support Center.

4. Under Product Support, select Sterling Integrator > Product Updates &

Downloads.
5. Select Sterling Integrator.
6. Under the Upgrading Sterling Integrator/GIS, select Request Upgrade Jar File

- Sterling Integrator Version Number. Where "Number" is the version you are
upgrading to.

7. Enter the following information for a Sterling B2B Integrator/GIS upgrade
request form:

* Company Name

* Billing Account Name
* Ship to Contact Name
* Ship to Street Address
* Email Address

* PSP number - The PSP Number (unique number that identifies a licensed
software asset in your Sterling B2B Integrator installation) is present in the
temporary or previous version of the keyfile you received from IBM.

* Delivery Method (ground shipment 5 - 7 days or electronic software
delivery)

* Current Software Version
* IP address
* License File key
* Operating System
8. Select the adapter that you are running from the list.

9. Click Submit. Your upgrade media is shipped to you with the delivery method
that you selected

Creating a process output log in Windows
About this task

A log of process activity during the upgrade helps if troubleshooting is required.
Output is automatically logged to the upgrade log files (PreInstal1Si.log and
InstallSi.log). Use this procedure to generate a separate output log for each

process you want to log.

In Windows, you must redirect the standard output and standard error of each
command to create a log file.

To create a process output log:
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Procedure

1. Enter a command similar to the following one: process.cmd >
processoutput.log 2>&1 Where process is the name of the command and
processoutput is the name of the output log. The log-writing process time
varies, depending on the size of your database and your system hardware.

Note: If you attempt to view the log while it is being written, the upgrade.cmd
script stops running and does not create a log of the upgrade process.

2. After you complete the command, you can review the output log with any text
editor.

Copying a Microsoft SQL Server 2000 database to an SQL Server
2005 database
About this task

Attention: This procedure is optional. It is the customer's responsibility to do
it.IBM Customer Support cannot help with this procedure.

Before you begin your upgrade, make a backup of your Microsoft SQL Server 2000
database. One way to accomplish this backup is to make a separate copy of your
existing database so that you can preserve your current system. If you are moving
from a Microsoft SQL Server 2000 database to an SQL Server 2005 database, use
the following procedure. Your existing Sterling Gentran Integration Suite instance
no longer functions if you upgrade your existing database without making a copy.

After this procedure, you will have two databases:
* A database that you use in your upgraded version of Sterling B2B Integrator.

* A database that you can use in your old version of Sterling B2B Integrator.

Procedure

1. Perform a full database backup to the file system on the source SQL 2000
server of the source database.

2. Copy the resultant backup (.bak) file from the file system on the source server
file system to the file system on the SQL 2005 server.

3. Connect to the SQL 2005 database server as a Windows authenticated user
with administrative privileges on the database server with SQL Server
Management Studio 2005.

4. Make sure that the destination database is not in use (disconnect any
connected applications).

5. Restore the backup of the SQL 2000 database over the existing SQL 2005
database with the Tasks | Restore | Database wizard. The restore is from a
“device,” the file that was previously created. Specify on the Options tab the
correct locations for the data and log files (since the locations in the backup
might not be the same as the correct locations for files on the on SQL 2005
database server). Select the check box to specify that the existing database is to
be overwritten. Confirm that the restore is reported as successful.

6. Check to make sure that existing users in the database match existing users on
the server with the command sp_change_users_login 'report'. If no rows are
returned, go to step 8.

7. If rows are returned, run the command sp_change_users_login 'update one',
‘username’, 'username' substituting the unlinked login name in each
execution to correct links between existing users in the restored database and
existing logins on the server.
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8. Examine the users of the database with the SQL Studio or sp_helpuser. If the
login (existing on the server) who is working with this database is not
currently a user of the restored database, add that login as a user of the
database by running the following commands (login_name and user_name are
generally the same):

USE database_name

Go

EXEC sp_grantdbaccess 'login_name', 'user_name'
Go

EXEC sp_addrolemember 'db_owner', 'username'
Go

CHECKPOINT

Go

USE master

Go

EXEC sp_defaultdb 'username', 'database_name'
Go

Note:

Do not include the spaces in the quoted strings in the SQL commands in the
final procedure, as spaces are significant to the procedure and the commands
fail if they are there (EXEC sp_grantdbaccess 'login_name', 'user_name' should
be EXEC sp_grantdbaccess 'login_name’, 'user_name').

9. Examine the user tables in the SQL 2005 database to determine which schema
they currently are in. Using the SQL Studio, the schema is the prefix before
each table listed in the Table tree.

Note:

This assumes that the schema of the user objects is not changed, even if it is a
schema name with the same name as a user other than the user who is
accessing the data.

10. Run the following command in the SQL 2005 database to ensure that the
default schema for the user who interacts with the database matches the
schema that contains the restored user objects. If the objects are in the dbo
schema, use dbo as the schema_name.

USE database_name

Go

ALTER USER user_name WITH DEFAULT_SCHEMA = schema_name
Go

What to do next

Note: You must configure Snapshot for your Microsoft SQL Server. For more
information, see the Configure Snapshot for Microsoft SQL Server topic.

Configure Snapshot for Microsoft SQL Server
About this task

The snapshot feature in Microsoft SQL Server allows you to view a read-only copy
of the database even when it is locked. Configuring the snapshot feature can also
reduce deadlocks.

Enter the following command to enable the snap shot feature:

ALTER DATABASE db_name SET READ_COMMITTED SNAPSHOT ON;
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Information Gathering Checklist

Information Gathering Checklist for Upgrades (Windows
Cluster)

Before you begin the upgrade, you should review the information in the
Information Gathering Checklist. The checklist contains all of the information that
you will need to have while running the upgrade scripts. Supporting information
and details are included at the end of this chapter.

The checklist contains:
* Brief descriptions for tasks (detailed procedures are provided after the checklist)
* Information you need to gather to prior the starting the upgrade

You may want to make a copy of the following checklist and use it to record the
information you collect for each node in the cluster.

The cluster environment does not support the following items:
* MySQL database
» AS2 Edition

Information Gathering Checklist for Windows
# Cluster Upgrades Your Notes

1 Review your IBM contract to determine what
software you have licensed. You need to know
this License Information so that you can select the
correct components/features to upgrade.

2 Determine which upgrade method you are going
to use:

¢ GUlI-based

* Silent Installation

3 Determine if you are going to run the pre-upgrade
checks during the upgrade.

4 Determine if you are going to use multicast ports.

5 Decide which type of security certificates you will
use:

* The default self-signed SSL (Secure Sockets
Layer) certificate that is automatically installed.

* A Certificate Authority-related certificate that
you install before installing the software.

6 If you are using an Oracle, SQL Server (2005 or
2008), or DB2 database, decide if you are going to
manually or automatically apply Database
Definition Language (DDL) Statements (schema)
to the database.

7 If you are using an Oracle 11.1 database, you must
set it up for native compilation by allocating space
and by setting the plsql_native_library_dir
parameter.

8 Determine if you are going to use FIPS (Federal
Information Processing Standards) mode.
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Information Gathering Checklist for Windows

# Cluster Upgrades Your Notes
Record the Hostname on which you plan to install
the software.

10 Record the Directory Name where you plan to
install the software.

11 Record the Login to host machine.

12 Record the Password to the host machine.

13 Record the path to the JDBC drivers.

14 Record the path to the installation wizard and file
name.

15 Record the path to JDK.

16 Record the path to JCE file.

17 Record the Host IP address.

18 Record the Initial Port Number.

19 Record the System passphase.

20 Record the Administrative e-mail address to
which system alert messages are sent.

21 Record the SMTP Server IP address used for
sending alert messages.

22 Record the Database vendor name.

23 Record the Database user name.

24 Record the Database password.

25 Record the Database (catalog) name.

26 Record the Database host name.

27 For Oracle or Microsoft SQL Server, record the
Path and file name for the JDBC Driver.

28 For DB2, record the Absolute paths and file names
for two JDBC drivers.

Supporting Information

Pre-upgrade check for clusters

Pre-upgrade checks reviews Oracle, SQL Server, and DB2 database environments
before the upgrade is started. This tool finds common upgrade errors. Run the
pre-check for node 1 only.

The pre-upgrade checks ensure:

SI_VERSION table exists

Database character set is correct for Oracle and DB2

Schedule start times are not later than the end times

The passphrase that is entered matches the existing passphrase in the database
Database implementation for Oracle Long Raw and BLOB

User has permission to perform the upgrade

Collation settings are validated for MS SQL

OBJECT_NAME is table SCI_ENTITY is no longer than 100 characters
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* Default schema that you identified during upgrade matches the existing
database

If any of these items are not validated, the upgrade fails. You are provided with an
error message and must correct the situations and then restart the upgrade.

License information

IBM provides the license files for each feature of Sterling B2B Integrator that you
purchased with the software media. You do not have to contact IBM customer
support to get the license files.

A separate license is required for each Sterling B2B Integrator feature that you
purchased. During installation, you must choose the license files according to what
you purchased. IBM customer support will audit your system after it is in use.

For more information about modifying licenses files, see the topic on License
Modification.

Multicast ports: node to node communications

Cluster nodes are configured to communicate with each other using JGroups, an
open source toolkit that provides flexibility for protocol configuration. JGroups
provides rich open management features, along with multiple protocol support.
JGroups supports multicast (UDP) and TCP-based communication protocols.

When JGroups is configured to use multicast (UDP), all cluster nodes communicate
with each other on a specific IP address and port. The multicast ports are
configured based on the installation base port. All clusters that are on the same
subnet that is configured on the same base port send multicasting messages on the
same multicast IP address and port.

To avoid this issue, each cluster on the same subnet must be configured on
different base ports. Install your clusters on different port ranges or on different
network segments with multicast forwarding restricted so that they do not
interfere with each other. The default multicast address that is used is
239.255.166.17. This address is configurable, with a port range of 10 ports, starting
with the multicast base port for the instance.

All nodes in the same cluster must be installed on the same multicast base port
(the multicastBasePort property in the
noapp.properties_platform_ifcresources_ext.in file). This port is computed from
the system base (non-multicast) port, but can be configured separately in the
noapp.properties platform_ ifcresources_ext.in file, to allow different nodes in a
cluster to be installed at different (non-multicast) port ranges. Also, install all the
nodes in the cluster in the same subnet.

For node to node communications, the properties are defined in
Jgroups_cluster.properties. The attributes that are used to define
communications are:

* property_string - default value is UDP.

* distribution_property_string - default value is TCP. Never set this attribute to
UDP.

If you want to change the communication for cluster multicast from the UDP

protocol to TCP, you must change the value of the property_string property in the
jgroups_cluster.properties.in file (after you back up the file), and then run the
setupfiles command. You can change this right after the installation or after you
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start running the cluster. If you change the file after you start the cluster, you must
stop all nodes of the cluster, change the value on each node, and then restart your
cluster.

To change the communication for cluster multicast from the UDP protocol to TCP,
use the following value for the property_string property in the
jgroups_cluster.properties.in file:
property_string=TCP(start_port=any_available_port_number):

TCPPING (initial_hosts=this_instance_host_ip[start_port_number],
theothernode_instance_host_ip[theothernode_start_port_number];port_range=2;
timeout=5000;num_initial_members=3;up_thread=true;down_thread=true):
VERIFY_SUSPECT(timeout=1500):

pbcast.NAKACK (down_thread=true;up_thread=true;gc_lag=100;retransmit_timeout=3000):
pbcast.GMS(join_timeout=5000;join_retry timeout=2000;shun=false;print local addr=
true;down_thread=true;up_thread=true)

For more information about UDP, TCP, and JGroups communications, refer to the
Sterling B2B Integrator Clustering documentation.

Security certificates
Before you begin the installation, you must decide which of the following security
certificates to use:

* The default self-signed SSL (Secure Sockets Layer) certificate that is
automatically generated by the installation.

* A Certificate Authority-related certificate that you generate before you install the
software.

If you install with the default SSL certificate, but you later want to switch to a
CA-related certificate, you can switch with the sslCert property in the
noapp.properties platform_ifcresources_ext.in file.

Port numbers in a Windows environment
During installation or an upgrade, you are prompted to specify the initial port
number for Sterling B2B Integrator.

To specify an initial port number, follow these guidelines:

+ Sterling B2B Integrator requires a range of 200 consecutive open ports within
the range of 1025 - 65535. The port range starts with the initial port number and
ends with the number that equals the initial port number plus 200. For example,
if you specify 10100, then you must make sure that 10100 through 10299 are not
used by any other applications on your system.

Note: Because of RMI, on occasion, a port number outside the range can be
assigned.

* The initial port number represents the beginning port number in the range.

* Make sure that port numbers in the port range are not used by any other
applications on your system.

For the other ports after the initial port, you can accept the default port number
suggested by the installation program, or you can individually reassign the
pre-assigned default port numbers within the specified port range.

During the upgrade, about 50 default ports are pre-assigned for different services.

For example, if you do not want xxx32 (10132) to be a default port, you can assign
that port to xxx97 or another number within the port range.

20 Windows Cluster Environment Upgrade:



After your installation or upgrade, refer to the \install_dir\install\properties\
sandbox.cfg file for all of the port assignments.

Database Definition Language (DDL) Statements

When you install Sterling B2B Integrator, you can manually apply Database
Definition Language (DDL) statements to your database tables instead of requiring
the installation process to do it directly.

This feature increases database security by reducing the database permissions of
the Sterling B2B Integrator database user. The rights to database objects can be
reserved for a secure user like a customer database administrator (DBA). A
business can require that only a DBA with the proper permissions can make
database changes.

Upgrade the Software

General Windows Cluster Upgrade Information

CAUTION: Sterling B2B Integrator should be installed behind a company firewall
for security purposes. See the Perimeter Server and Security topics in the Sterling
B2B Integration documentation library for more information on secure deployment
options.

Upgrade Methods

Use one of the following methods to upgrade your system:
* Upgrade a Cluster using the GUI-Based method
* Upgrade a Cluster using the Silent Install File method

The cluster environment does not support the following items:
* MySQL database
* AS2 Edition

Windows Cluster Information

Upgrading Sterling B2B Integrator cluster nodes is similar to upgrading a Sterling
B2B Integrator single node, with the following restrictions on all nodes:

* All nodes must use the same database.
+ All nodes must use the same passphrase.
* All nodes must use the same operating system.

* When installing nodes on different machines, the initial port numbers must be
the same. Installing nodes on different machines helps you take more advantage
of the reliability, availability, and scalability features of clustering, including
failover.

* When installing nodes on the same machine, you must install nodes 2 and
higher in different directories and use different initial port numbers. Each initial
port number must be at least 100 higher or lower than other initial port
numbers.

* Nodes must be installed sequentially, one at a time, starting with the first node.

 After installing all of the nodes, nodes must be started sequentially, one at a
time, starting with the first node.

* Obtain a valid Sterling B2B Integrator license for multiple IP addresses of all the
nodes where Sterling B2B Integrator will be installed and configured as a cluster.
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* To install more than one instance of Sterling B2B Integrator on the same
Windows server, you must install the second instance in a different directory.

* If you are using FIP to copy the files, verify that your session is set to binary
mode.

* Sterling B2B Integrator does not support IPv6 installation on Windows. Before
applying an IPv6 address, see the IPv6 Capabilities section in Sterling B2B
Integrator System Requirements guide.

* If you are installing Sterling B2B Integrator on VMware, provide the IP address
of the virtual machine, not the IP address of the VMware host. For example, if
10.251.124.160 is the IP address of the VMware host and 10.251.124.156 is the IP
address of the Windows 2003 server it is hosting, you should use 10.251.124.156
as the correct IP address to install Sterling B2B Integrator.

* Clustering is not supported for Sterling B2B Integrator systems that use the
MySQL database, even though it appears as an option.

* The installation creates subsequent ports based on the initial port number. For
all of the port assignments, see the \install_dir\install\ properties\sandbox.cfg
file.

* If you are running the upgrade on an active installation of Sterling B2B
Integrator, you will need to run the soft stop command to gracefully stop traffic.
For more information on performing a soft stop, see the Soft Stop
documentation in the System Administration Guide on the Sterling B2B
Integrator 5.2 Information Center.

Installation Wizard Information

The installation wizard provides:

* The option of either entering the paths or selecting (Select File) the paths and
files.

* For every screen in the wizard, you need to click Next to move to the next step
the wizard. The click Next step is not represented in each step in the procedure.

Upgrade the Cluster using the GUI-Based Method in Windows
About this task

Before you begin:
* You should have completed the Information Gathering Checklist for Upgrades.

* install_dir refers to the installation directory where the software is installed. Do
not use any pre-existing directory name or an old version of the Sterling B2B
Integrator installation directory. If you do, you could inadvertently overwrite the
existing installation.

* This upgrade changes the administrative password to the default password.
After the upgrade, change the password back to the administrative password to
minimize security risks. This is the Admin password for logging into the Ul
(/dashboard or /ws).

To upgrade, starting with node 1:

Procedure
1. Close all open Windows programs and any command prompt windows.

2. From the installation media, copy IBMInstallWizard.jar and SLjar to your
desktop or to a Windows directory.

3. To start the upgrade, use one of the follow methods:
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For Windows Server 2003 or earlier For Windows Server 2008

* Open a command prompt window (from Complete the following steps:

the Run dialog box). * Click Start.
* Enter \path_to_java\bin\java -jar * Right-click Command Prompt and select
\absolutePath\IBMInstallWizard.jar Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

* Enter \path_to_java\bin\java -jar
\absolutePath\I1BMInstallWizard.jar

o

1.
12.
13.
14.

15.

16.

17.

18.

The installation dialog box appears.

Click Next to start the upgrade.

Enter the full path to the JDK directory.

Select the Licenses/Features to install. The following list is displayed:
 IBM Sterling B2B Integrator and/or IBM Sterling File Gateway

* FIPS Module

* AS2 Edition Module

* Financial Services Module

+ EBICS Banking Server Module

Note: Select only the licenses/features that have been defined by your IBM
contract. If you are unsure which to select, the installation can proceed
without making a selection and will complete successfully. Start up and
operation of the software, however, requires one of the licenses to be selected.
See License Modification to apply licenses post-install.

Note: Sterling File Gateway requires additional installation steps. See the
Sterling File Gateway Installation Guide for more information.

Enter the full path to your JCE file.

Enter the path to installation directory. If the directory does not exist, click Yes
at the prompt The directory does not exist, create it?.

The installer creates the installation directory. This installation directory is
referred to as install_dir. Below the installation directory, the installer creates a
directory named install. This directory contains the installation files.

Enter the path to the install jar file (SLjar).

Enter the explicit IP address for the server or use the default value of
localhost.

Enter the initial port number or use the default value of 8080.
Enter your system passphrase.
Re-enter the system passphrase.

Enter the administrative e-mail address to which you want system alert
messages sent.

Enter the SMTP mail server (IP address or host name) that you want to use
for system alert messages and other administrative notices.

If you want to enable FIPS (Federal Information Processing Standards) mode,
select the checkbox. The default is disable FIPS mode.

Select the database that you want to use (Oracle, Microsoft SQL Server, DB2,
or MySQL). Clustering is not supported for Sterling B2B Integrator systems
that use the MySQL database, even though it appears as an option.

Select all options that apply to this node:
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Choices: Action

(Skip for Version 5.2.0) This installation |Select this option. By default, the checkbox is

is an upgrade from a prior version. not selected.

This installation is for a cluster node 2 « For node 1: Do not select the check box.
or higher * For node 2 or higher: Select the check box.
(Skip for MySQL) If yes, no action required. The default is to

Apply database schema automatically?

automatically apply the DDL statements.

If you want to manually create the database
schema, then clear the Apply database schema
automatically check box and continue with the
remaining installation steps.

Note: Once the install starts, it will run for a
short time and then exit. When the installation
stops, you must perform additional actions as
given in Step 26 of this procedure..

Verbose install?

* By default, the check box is not selected.

* Select the checkbox to generate the installation
log. The events that occur during the
installation are recorded in InstallSI.log file.

19. Enter the database connection information.

20.

Database user name

Database password (and confirmation)
Database catalog name

Database host name

Database port

(Oracle and Microsoft SQL Server only) Absolute path and file name for one
JDBC driver file

(DB2 only) Absolute paths and file names for two JDBC driver files

Use the Type-4 JDBC driver. This type of driver converts JDBC calls into the
network protocol used directly by DB2, allowing a direct call from Sterling
B2B Integrator to the DB2 server.

(Oracle only) Select the check box to select the data type to use for caching.
Select either the default BLOB (binary large object) columns data type or the
Long Raw data type.

You can significantly improve performance by enabling the cache on the
BLOB data object in Oracle. For more information, refer to the Sterling B2B
Integrator documentation for slow performance in Oracle.

Review and confirm the database information.

21. Do you want to run the Upgrade Pre-check?

If yes, click Next. Default is Yes. You only need to run the pre-check for

node 1 in the cluster. Then you will need to Confirm Running Upgrade
Pre-Check. If the pre-check generates an error message, you will need to
resolve the error situation, before the upgrade can be restarted.

If no, click No to skip the pre-check.

22. Review the default Install Actions. The following check boxes are
automatically selected and you can not clear them:

Verify Operating System is supported
Verify the selected JDK is supported
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23.
24.

25.

26.

¢ Install Components

* Save install files

* Clean Up Files

¢ Install Windows Service

Select the appropriate JDK. By default, the 64-bit JDK is selected.

If you want to Create Desktop Icons (Windows & Linux), click Next. By
default, the check box is selected. If you created the desktop icon and are
using Windows Server 2008, you need to complete the Configure the Desktop
Icon for Windows Server 2008 task after the installation is complete.

Click Next to continue.

The Installation Progress screen appears. You can click Show Details to
confirm your installation information before starting the installation.

Click Install to finish the upgrade.

The Installation Progress screen shows the general progress of the installation
through different stages. For more information about these stages, click Show
Details.

Note: If you DID NOT select the option to Apply database schema
automatically , the installation stops and you must perform these additional
steps:

Important: In version 5.2.x ofSterling B2B Integrator, there is an issue with
manually applying the database schema and the installation wizard. Once you
start the installation, an error occurs as the SQL scripts are generated. A dialog
box appears with the message, Install failed Error running the install.

To complete the installation with manual DDL statements:

a. Navigate to your install directory.

b. Locate the PrelnstallSI.log file and open it with a file editor.
C. Search the file for these error messages:

* <SI_Install>/repository/scripts/EFrame_IndexAdds.sql must be applied
to the database.

* <SI_Install>//repository/scripts/EFrame_Sequence.sql must be applied
to the database.

* <SI_Install>//repository/scripts/EFrame_TableChanges.sql must be
applied to the database. Exiting installation..."

Note: If you do not find the above error messages in the log file, the
installation failed because of another reason and you must resolve that
error and attempt the installation again. If you did find these messages,
continue with the remaining steps.

d. Edit each .sql script and make changes appropriate for your database. This
may include changing the SQL delimiter or adding tablespace options.

e. Log in to your database as the DB schema user.
f. Execute the SQL files manually in this order:

Note: When you are executing the scripts, it is important to execute the
SQL scripts in the specified order.

* EFrame_IndexDrops.sql
* EFrame_TableChanges.sql
* EFrame_IndexAdds.sql
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27.

* EFrame_TextIndexAdds.sql
* EFrame_Sequence.sql
* EFrame_TextIndexModify.sql
* EFrame_TextIndexUpdates.sql
* EFrame_TextIndexUpgrade.sql
* EFrame_Static.sql
g. Exit from the database.
h. Navigate to the parent directory of install_dir.

i. Delete (or Rename as a backup) the Sterling Integrator install directory.

j. Restart the installation wizard and provide the same installation options
you provided before including clearing the Apply database schema

automatically check box.

The installation completes automatically. When the installation is finished, the

system displays a dialog box with the message Installation Wizard
completed. Please see the installation guide for next steps.

Installation information is in the following files:
* PrelnstallSI.log

* ant.install.log

* InstallSIL.log

If you used different base ports for node 2 onward, you need to complete the

following additional steps:

Step

Action

Your Notes

Navigate to \install_dir\install\properties for node 1.

In the noapp.properies_platform_ifcresources_ext file, record
the value for multicastBasePort.

In the jgroup_cluster.properties file, record the value for
mcast_port.

For each subsequent node, you need to perform the
remaining steps.

Navigate to \install_dir\install\properties for each node
(node 2 and higher).

In the noapp.properies_platform_ifcresources_ext.in file,
update the value of the multicastBasePort to match the value
for node 1.

For example, replace the string
&MULTICAST_NODE_PORT1; with the port number 45460:

* (before) multicastBasePort=4MULTICAST_NODE_PORT1;
* (after) multicastBasePort=45460

In the jgroups_cluster.properties.in file, update all
occurrences of the mcast_port property to match the values
for node 1.

After you have updated the attributes for all of the nodes,
enter:

\install_dir\install\bin\setupfiles.cmd for node 2 and
higher.

28. On each node, starting with node 1, run the command startCluster.cmd
nodeNumber from the \install_dir\install\bin directory where nodeNumber
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is the sequential number assigned to each node starting with 1. For example,
on the first two nodes, you would run the following commands:

For Node 1:
startCluster.cmd 1

When the cluster environment is configured, you will get the message BUILD
SUCCESSFUL.

For Node 2:
startCluster.cmd 2
Enter the passphrase.

When the cluster environment is configured, you will get the message
Deployment to application server successful.

29. After the cluster configuration is complete, go to the \install_dir\install\bin
directory for each node, starting with the first node, enter:

StartWindowsService.cmd
When prompted, enter the passphrase that you entered earlier.
The final startup processes run, concluding with the following messages:

Open your Web browser to http://host:port/dashboard, where host:port is the IP
address and port number where Sterling B2B Integrator resides on your
system.

Depending on system load, it may take several minutes for the UI to be ready.

Make a note of the URL address so that you can access Sterling B2B Integrator
later.

To make a dynamic addition of new nodes to the cluster, install new nodes to
the cluster as described above and configure the servers for the cluster.

30. Determine if you need to apply any maintenance patches to the installation.
Refer to System Maintenance to get information on how to install the latest
patch.

Silent Installation Method for Upgrades

The silent installation method automates part of the upgrade process and limits
your manual interaction with the upgrade program. To use the silent installation
method, you will need to first create a silent install file using a text editor.

Create the Silent Installation File for the Windows Cluster
Upgrade
About this task

The following entries correlate to prompts in the Install Using the GUI-Based
method procedure. Create a silent installation file with the following variables:

Note: Special characters need to be proceeded by a \ (backslash) esc character.

Entry

Description

ACCEPT_LICENSE

(Required) Indicates if the user accepts the license agreement.

Default: YES

JVM_LOC

(Required) Full path to JDK directory.

LICENSE_FILE_PATH

(Required) Full path to Core_License.xml

The Core_License.xml file is located on the same media as the install wizard jar
and the installation jar.
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Entry

Description

LICENSE_FILE_# (where # is a
number between 1 and 99)

(Required) This is required for each license you install. You need to add an
entry for each license file to the silent install file. The LICENSE_FILE
numbering (#) does not need to be sequential.

For example:

LICENSE_FILE_ 1= SI_SFG_License.xml
LICENSE_FILE_2= Fin_Serv_License.xml
LICENSE_FILE_3= SSI_SFG_FIPS_License.xml
LICENSE_FILE 4= AS2_License_.xml

LICENSE_FILE_5= EBICS_License_.xml

SI_LICENSE_AVAILABLE

(Optional) Indicates if a license is being passed in and is required for the
installation.

Default: YES

JCE_DIST_FILE

(Required) Full path to unlimited strength JCE policy file. If present, this file
will overwrite the JCE file in the JDK.

INSTALL_DIR

(Required) Directory that includes the bin subdirectory (where many
commands are stored) and the properties subdirectory (where many properties
are stored).The INSTALL_DIR property cannot point to a pre-existing directory,
or the installation will fail.

REINIT_DB

(Required) Indicates if database should be initialized.
» For node 1 of a cluster, this property is true.

* For node 2 and higher of a cluster, this property is false.

Default: true

CLUSTER

(Required) Indicates if this is the second or higher node of a cluster installation.

Valid values:
* true - This is the second or higher node of a cluster installation.

* false (default) - This is the first node of a cluster or a single node
(non-cluster) installation.

INSTALL_IP

(Required) Host name or IP address.

Valid values:
* localhost (default)
* Your IP address or host name

If you are installing Sterling B2B Integrator on VMware, provide the IP address
of the virtual machine, not the IP address of the VMware host. For example, if
10.251.124.160 is the IP address of the VMware host and 10.251.124.156 is the IP
address of the Windows 2003 server it is hosting, you should use 10.251.124.156
as the correct IP address to install Sterling B2B Integrator.

Note: Sterling B2B Integrator does not support IPv6 installation on Windows.
Before applying an IPv6 address, see the IPv6 Capabilities section in the System
Requirements.

You must install using a host name, not an IPv6 address, otherwise the
Lightweight JDBC adapter and Graphical Process Modeler (GPM) will not
work.
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Entry

Description

PORT1

(Required) Base port for ASI server. Ports are assigned consecutively from this
port.

Default: 8080

APSERVER_PASS

(Required) Passphrase used to secure all encrypted data in database.

SI_ADMIN_MAIL_ADDR

(Required) E-mail address for the administrative user.

Example: abc@xyz.com

SI_ADMIN_SMTP_HOST

(Required) Valid SMTP host through which the system can e-mail the
administrative user.

Example: mail.xyz.com

FIPS_MODE

(Optional) Indicates if you are using FIPS (Federal Information Processing
Standards) mode.

Valid values:
* true - Enable FIPS mode.
* false (default) - Disable FIPS mode.

DB_VENDOR

(Required) Database vendor.

Valid values:

* Oracle

* MSSQL2005 (use this value for Microsoft SQL 2005 and 2008)
* DB2

* MySQL

UPGRADE

(Required) Indicates if you are upgrading. Set this value to true.

Default: false

DB_CREATE_SCHEMA

(Required) Indicates if you want the database schema automatically created.

Valid values:
* true (default) - Automatically create the schema.

* false - Manually create the schema.

If you create the database schema manually, restart the installation procedure in
a new installation directory. You can delete the installation directory created
earlier.

DEBUG (Optional, highly recommended) Records events that occur during the
installation in InstallSIlog file.
Valid values:
* true - records events that occur during the installation.
* false (default) - does not record the events that occur during installation.
DB_USER (Required) Database user name.
DB_PASS (Required) Database password.
DB_DATA (Required) Database catalog name.
DB_HOST (Required) Database host name.
Default: localhost
DB_PORT (Required) Database port.
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Entry

Description

DB_DRIVERS

(Required) Full path to JDBC driver files. If DB_VENDOR is:
* Oracle or MSSQL, specify one driver.
* DB2, specify two drivers.

If you specify more than one driver, use colons (:) to separate the file names.

Examples:
* JDBC_driver_dir\db2jdbc.jar
* JDBC_driver_dir\db2_1_jdbc.jar:J]DBC_driver_dir\db2_2_jdbc jar

ORACLE_USE_BLOB

(Required if DB_VENDOR=Oracle) Indicates the data type to use for caching.
* true (default) - BLOB (binary large object)

* false - Long Raw

MSSQL2005

(Required for Microsoft SQL Server 2005) This attribute is case-sensitive.
» Set this attribute to the default value of true.

* (All other servers) Do not include this attribute.

JDK64BIT

(Optional) Indicates if a 32-bit or 64-bit JDK is being used. Refer to the System
Requirements to determine the type of JDK for your operating system.

Valid values:
* true (default) - 64-bit
e false - 32-bit

Icons

(Required) Indicates whether to create a desktop icon for accessing Sterling B2B
Integrator.

Valid values:
* true - Create a desktop icon.

* false (default) - Do not create a desktop icon.

If you created the desktop icon and are using Windows Server 2008, you need
to complete the Configure the Desktop Icon for Windows Server 2008 task after the
installation is complete.

The following entries do not directly correlate to prompts in the installation
procedure. Use these entries to customize or document your installation.

Entry

Description

DB_DRIVERS_VERSION

(Optional) Free form version string for JDBC driver. This is informational only.

Example: 8_1_5

JDBC_VENDOR

JDBC driver vendor. Used when multiple vendors are available (DB2 iSeries:
DB2APP, DB2TOOLBOX, DB2).

Default: Microsoft

LOAD_FACTORY_SETUP

(Optional) Indicates whether factory setup should be loaded during installation.
To manually set LOAD_FACTORY_SETUP to false after an installation where
LOAD_FACTORY_SETUP=true (the default value), change
LOAD_FACTORY_SETUP to false in sandbox.cfg file.

Valid values:
* true (default).- loads factory setup during installation.

+ false - does not load factory setup during installation. Run loadDefaults
command after installation.
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Entry

Description

CONFIG_GS

(Optional) Indicates whether integration with Sterling Gentran:Server® should
be configured.

Default: No

NO_DBVERIFY

(Optional) Valid values are true or false. When set to true during installation
and installservice, dbverify will not be run.

This means that Sterling B2B Integrator will not generate DDL to make the
database like the XML entity repository.

DB_CLEAN

Indicates if database should be wiped at the beginning of the installation.

Default: no

Upgrade the Cluster Using a Silent Installation File (Windows
Cluster)
About this task

Before you begin, you should have already created the silent install file.
To upgrade in the windows cluster environment using a silent installation file:

Procedure
1. From the installation media, copy Sljar to a Windows directory.

2. If you want to run the upgrade pre-check, from the upgrade media, copy
IBMUpgradePreCheck.jar to a Windows directory.

3. Set up your silent installation file and record the location.

4. If you want to run the pre-check, in a command window enter the following

(which includes paths to the JDK, the IBMUpgradePreCheck jar file, and the
silent installation file):

\absolutePath\bin\java -jar \absolutePath\IBMUpgradePreCheck.jar -f
\absolutePath\SilentInstallFile

The validation starts. If the pre-check generates an error message, you must
resolve the error situation, before the upgrade can be restarted. When the
pre-check finishes without any errors, the system displays the following
message: SI upgrade pre-check has been completed successfully

5. To start the upgrade, use one of the follow methods:

For Windows Server 2003 or earlier

* Open a command prompt window (from the Run dialog box).
* Enter

\absolutePath\bin\java -Xmx512m -jar
\absolutePath\SI.jar -f
\absolutePath\SilentInstallFile
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For Windows Server 2008

Complete the following steps:

 Click Start.

* Right-click Command Prompt and select Run as administrator.
The Administrator: Command Prompt dialog box is displayed.

* Enter

\absolutePath\bin\java -Xmx512m -jar
\absolutePath\SI.jar -f
\absolutePath\SilentInstallFile

The installation begins. The program verifies support for your operating
system and JDK. You can follow the progress of the installation on screen.

When the installation is finished, the system displays the following message:
Installation has completed successfully.

Note: Select only the licenses/features that have been defined by your IBM
contract. If you are unsure which to select, the installation can proceed
without making a selection and will complete successfully. Start up and
operation of the software, however, requires one of the licenses to be selected.
See License Modification to apply licenses post-install.

Note: Sterling File Gateway requires additional installation steps. See the
Sterling File Gateway Installation Guide for more information.

6. (Skip this step if you are applying database schema automatically.) If you are
going to manually create the database schema, the install starts and runs for a
short time before exiting.

Note: After the installation stops, you must perform these additional steps:
a. Navigate to your install directory.

b. Locate the PrelnstallSI.log file and open it with a file editor.

C. Search the file for these error messages:

* <SI_Install>/repository/scripts/EFrame_IndexAdds.sql must be applied
to the database.

* <SI_Install>/ /repository/scripts/ EFrame_Sequence.sql must be applied
to the database.

* <SI_Install>/ /repository/scripts/EFrame_TableChanges.sql must be
applied to the database. Exiting installation..."

Note: If you do not find the above error messages in the log file, the
installation failed because of another reason and you must resolve that
error and attempt the installation again. If you did find these messages,
continue with the remaining steps.

d. Edit each .sql script and make changes appropriate for your database. This
may include changing the SQL delimiter or adding tablespace options.

e. Log in to your database as the DB schema user.
f. Execute the SQL files manually in this order:

Note: When you are executing the scripts, it is important to execute the
SQL scripts in the specified order.

* EFrame_TableChanges.sql
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* EFrame_IndexAdds.sql
* EFrame_TextIndexAdds.sql
* EFrame_Sequence.sql
* EFrame_TextIndexModify.sql
* EFrame_TextIndexUpdates.sql
* EFrame_TextIndexUpgrade.sql
» EFrame_Static.sql
g. Exit from the database.
h. Navigate to the parent directory of install_dir.
i. Delete (or Rename as a backup) the Sterling Integrator install directory.

j. Restart the installation wizard and provide the same installation options

you provided before including clearing the Apply database schema
automatically check box.

7. To upgrade each subsequent node, from node 2 onwards and if you are

installing nodes on separate machines, enter the same information in the silent

installation file that you entered for node 1, with the following exceptions:

* Set REINIT_DB=false. This prevents the database from being re-initialized.

* Set CLUSTER=true.
* Use a different installation directory for each node (the INSTALL_DIR
property).

* Use an initial port number that is 200 port numbers higher or lower than

the initial port number on other nodes (the PORT1 property). Each node
will be configured on a different port range.

After all the nodes are installed, proceed to the next step.
8. To start the installation of nodes 2 and higher of the cluster:

For Windows Server 2003 or earlier

* Open a command prompt window (from the Run dialog box).
* Enter

\absolutePath\bin\java -Xmx512m -jar
\absolutePath\SI.jar -f
\absolutePath\SilentInstallFile

- cluster

For Windows Server 2008

Complete the following steps:

* Click Start.

* Right-click Command Prompt and select Run as administrator.
The Administrator: Command Prompt dialog box is displayed.

* Enter

\absolutePath\bin\java -Xmx512m -jar
\absolutePath\SI.jar -f
\absolutePath\SilentInstallFile

- cluster

Windows Cluster Environment Upgrade (5.2.0 -5.2.2)

33



9.

If you used different base ports for node 2 onward, you need to complete the
following additional steps:

Step

Action Your Notes

1

Navigate to \install_dir\install\properties for node
1.

In the noapp.properies_platform_ifcresources_ext
file, record the value for multicastBasePort.

In the jgroup_cluster.properties file, record the
value for mcast_port.

For each subsequent node, you need to perform the
remaining steps.

Navigate to \install_dir\install\properties for each
node (node 2 and higher).

In the noapp.properies_platform_ifcresources_ext.in
file, update the value of the multicastBasePort to
match the value for node 1.

For example, replace the string
&MULTICAST_NODE_PORT1; with the port number
45460

* (before) multicastBasePort=
&MULTICAST_NODE_PORT1;

* (after) multicastBasePort=45460

In the jgroups_cluster.properties.in file, update
all occurrences of the mcast_port property to match
the values for node 1.

After you have updated the attributes for all of the
nodes, enter:

\install_dir\install\bin\setupfiles.cmd for node 2
and higher.

10.

11.

12.

On each node, starting with node 1, run the command startCluster.cmd
nodeNumber from the \install_dir\install\bin directory where nodeNumber
is the sequential number assigned to each node starting with 1. For example,
on the first two nodes, you would run the following commands:

For Node 1:
startCluster.cmd 1

When the cluster environment is configured, you will get the message BUILD
SUCCESSFUL.

For Node 2:
startCluster.cmd 2
Enter the passphrase.

When the cluster environment is configured, you will get the message
Deployment to application server successful.

Once the cluster configuration is complete, go to the \install dir\install\bin
directory for each node and issue the following commands to install and start
Windows services:

InstallWindowsService.cmd startWindowsService.cmd
Enter your passphrase.
The final startup processes run, concluding with the following messages:
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13.

14.

Open your Web browser to [URL]

Depending on system load, it may take several minutes for the UI to be ready.
Make a note of the URL address so that you can access Sterling B2B Integrator
later.

The system returns you to a Windows prompt.

To make a dynamic addition of new nodes to the cluster, install new nodes to
the cluster as described above and configure the servers for the cluster.

Determine if you need to apply any maintenance patches to the installation.
Refer to System Maintenance to get information on how to install the latest
patch.

From the installation directory, install windows services by running the
command installWindowsService.cmd.

Configure the Sterling B2B Integrator Desktop Icon for
Windows Server 2008
About this task

User Access Control (UAC) is a security component in Windows Server 2008. If
you enable the UAC, it affects the installation process and the daily processing for
Sterling B2B Integrator. If you disable the UAC, which requires a reboot, the
installation process and daily processing for Sterling B2B Integrator remains the
same as in previously supported Windows version.

If you installed or upgraded Sterling B2B Integrator on a Windows Server 2008 and
you created a desktop icon for Sterling B2B Integrator, you must complete this task
in order for the desktop icon to work.

Procedure

1. Right-click on the Sterling B2B Integrator desktop icon.
2. Click Properties.

3. In the Shortcut tab, click Advanced.

4. Select the check box for Run as Administrator.

5. Click OK to apply the changes to Advanced Properties.
6. Click OK.

Validate the Software

Validate the Cluster Upgrade Checklist

As part of the upgrade, you need to run the following tests to ensure that the
software upgrade was successful. All of the following tests are not required.
Complete the following tasks:

Number | Validate Cluster Upgrade Task Completed

Verify the Cluster Environment Settings in Property Files.

Configure the Nodes in Windows Cluster.

Start the Windows Cluster.

Access Sterling B2B Integrator.

Validate the Installation (Sample Business Process).

1
2
3
4
5
6

Verify the Cluster is Running from the User Interface.

Windows Cluster Environment Upgrade (5.2.0 -5.2.2) 35



Number | Validate Cluster Upgrade Task Completed

7 Stop a Node in the Windows Cluster Configuration.
8 Stop Sterling B2B Integrator (Windows Cluster).
9 Stop Sterling B2B Integrator in a Windows Cluster Environment

(Hardstop or Softstop).

10 Restart the Windows Cluster.

Verifying the cluster environment settings in property files
About this task

To verify the cluster environment is correct, check these property settings on node
2.

Note: If these property settings are not in place, then add them to the appropriate
property file.

Procedure

1. Navigate to /install_dir/install/properties.

2. Verify that CLUSTER=true is in the sandbox.cfg file.

3. Verify that cTuster=true is in the centralops.properties file.
4

. Verify that cluster=true is in the
noapp.properties platform ifcresources_ext file.

5. Verify that clustered_env=true is in the ui.properties file.

Configuring the nodes in a Windows cluster
About this task

The first time that you configure a cluster, you must use the startCluster command
with true option (startCluster.cmd nodeNumber true). Initial configuration is the
only time that you must use the startCluster command. However, if you must
use the command again, use the startCluster command with the false option
(startCluster.cmd nodeNumber false). The false option prevents any configuration
changes from affecting the system, especially after installation of a fix pack or
interim fix.

To configure the nodes in a Windows cluster environment, you must do the
following task for each node, starting with node 1:

Procedure

1. Navigate to \install_dir\install\bin for the node with one of the following
methods:

For Windows Server 2003 or earlier For Windows Server 2008

Open a command prompt window (from the | Complete the following steps:
Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.
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2. Enter startCluster.cmd <nodeNumber> <true or false>. Where <nodeNumber>
is the number of the node, true runs database updates and false prevents
database updates. For example, for node 1, enter ./startCluster.cmd 1 true.

3. Enter startWindowsService.cmd. Perform this step for each node. The final
startup processes run, concluding with the following message: Open your Web
browser to http://host:port/dashboard Where host:port is the IP address and
port number on your system.

4. Record the URL address so that you can access Sterling B2B Integrator.

Starting the Windows cluster
About this task

For each node in the cluster, starting with nodel:

Procedure
1. Navigate to \install_dir\install\bin with one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. Enter startWindowsService.cmd.

w

Enter your passphrase.

4. The final startup processes run, concluding with the following message: Open
your Web browser to http://host:port/dashboard

Where host:port is the IP address and port number where Sterling B2B
Integrator is located on your system.

Depending on system load, it might take several minutes for the UI to be ready.
5. Record the URL address so that you can access Sterling B2B Integrator.

What to do next

If you must release all the locks in a cluster and both nodes are down, use the
restart parameter for node 1.

Note: The restart parameter can be used on node 1 only and cannot be used on
any other nodes.

For example:

For node 1, enter:
startWindowsService.cmd restart
For nodes 2 and higher, enter:

startWindowsService.cmd
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Accessing Sterling B2B Integrator
About this task

To log in to Sterling B2B Integrator:

Procedure

1.

Open a browser window and enter the address that is displayed at the end of
startup. The login page displays.

Enter the default user ID and password. The default login is at an
administrative level. One of your first tasks as an administrator is to change the
administrative password and to register other users with other levels of
permission.

Testing a sample business process to validate the installation
About this task

Validate the installation by testing a sample business process:

Procedure

1.

ok~ 0N

From the Administration Menu, select Business Process > Manager.

In the Process Name field, enter Validation _Sample BPML and click Go!
Click execution manager.

Click execute.

Click Go! The Status: Success message displays in the upper left side of the
page.

Verifying that the cluster is running from the user interface
About this task

To verify that the cluster is running from the user interface (UI):

Procedure

1.

From the UI, from the Administration Menu, select Operations > System >
Troubleshooter. Ensure you can view the Queue information for each node.
From the UI, from the Administration Menu, select Operations > System >
Troubleshooter. Ensure you can view the JNDI Tree for each node.

From the Ul, from the Administration Menu, select Operations > System >
Troubleshooter. Ensure you can view the host, state, status, adapters, and
memory usage information for each node.

From the UI, from the Administration Menu, select Operations > System >
Troubleshooter. Ensure you can view the adapter status for each node.

Stopping a node in a Windows cluster configuration (hard

stop)

About this task

You can stop a single node Sterling B2B Integrator in a Windows cluster
environment. To run a hard stop, do this task for each node:
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Procedure

1. Navigate to \install_dir\install\bin with one of the following methods:

For Windows Server 2003 or earlier

For Windows Server 2008

Open a command prompt window (from the
Run dialog box).

Complete the following steps:

Click Start.

Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. Enter StopWindowsService.cmd.

3. Enter your passphrase. You can also do this task by selecting Operations >
System > Troubleshooter, and then click the shutdown link for the node you

want to stop.

Stopping Sterling B2B Integrator (Windows cluster)

About this task

To stop the entire cluster in a Windows environment:

Procedure

1. From the Administration menu, select Operations > System > Troubleshooter.
2. Click Stop the System and wait for shutdown to complete.

Stopping Sterling B2B Integrator (hard stop Windows)

About this task

To stop Sterling B2B Integrator in a Windows environment:

Procedure

1. Navigate to \install_dir\install\bin with one of the following methods:

For Windows Server 2003 or earlier

For Windows Server 2008

Open a command prompt window (from the
Run dialog box).

Complete the following steps:

Click Start.

Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. Enter StopWindowsService.cmd. You receive a message that services were
stopped. Services include Noapps, Opsserver, WebDAV, and Database-related

service.

Stopping cluster (soft stop Windows)

About this task

Soft stop in a cluster environment suspends all scheduled bushiness processes. Run
the hard stop command on each of the nodes.

To soft stop the cluster:
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Procedure

1. Navigate to \install_dir\install\bin with one of the following methods:

For Windows Server 2003 or earlier

For Windows Server 2008

Open a command-prompt window (from the
Run dialog box).

Complete the following steps:

Click Start.

Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. Enter softstop.cmd. You receive a message that services are stopped. Services
include Noapps, Opsserver, WebDAYV, and Database-related services.

For more information, see the Performance Management documentation.

Restarting the Windows cluster
About this task

To restart the entire cluster in a Windows environment:

Procedure

1. Navigate to \install_dir\install\bin with one of the following methods:

For Windows Server 2003 or earlier

For Windows Server 2008

Open a command prompt window (from the
Run dialog box).

Complete the following steps:

Click Start.

Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. Enter startWindowsService.cmd restart.

What to do next

If you must release all the locks in a cluster and both nodes are down, use the

restart parameter for node 1.

Note: The restart parameter can be used on node 1 and cannot be used on any

other nodes.

For example:

For node 1, enter:
startWindowsService.cmd restart
For nodes 2 and higher, enter:

startWindowsService.cmd
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Post Upgrade Configuration

not be required.

Post Upgrade Configuration Checklist (Windows Cluster)

The upgrade is complete. You need to now perform some post upgrade
procedures. Review all of the procedures in the checklist. Some procedures may

# Post Upgrade Configuration Checklist Your Notes

1 For security purposes, change all default user ID passwords
immediately after installation is completed. See the Update My
Account Information task in the documentation library.

2 Determine if You Need to Apply a Maintenance Patch to the
Cluster

3 Change the Administrative Password

4 Configure Cluster Environment in Windows

5 Changes to Network Interface Bindings

6 Disable Services

7
Download Sterling B2B Integrator Tools

8 Enable Business Processes

9 Configure Property Files

10 Add cdinteropfiles

11 Add Third-Party Libraries

12 Review the EDI Sequence Check Sequence

13 Configure Document File Systems

14 Configure Services and Adapters

15 Configure JDBC Adapter and Lightweight JDBC Adapter

16 Configure File System Adapter and Command Line2 Adapters

17 Configure Odette FTP Adapter

18 Restore Performance Tuning Configuration

19 Add Advanced File Transfer Tab

20 Reconfigure Archive Settings

21 Correct Missing Manager ID

22 Manage Nodes in a Cluster

23 Configure ActiveMQ for a Cluster Environment

24 Configure Shared File System as Document Storage

25
Add host[port] From all the Nodes to the
jgroups_cluster.property.in for Each Node

26 Configure JVM Containers

About this task

For each node in the cluster, starting with nodel:
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Procedure
1. Navigate to \install_dir\install\bin using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. On each node, starting with node 1, run the command startCluster.cmd
nodeNumber. Where nodeNumber is the sequential number assigned to each
node starting with 1. For example, on the first two nodes, you would run the
following commands:

For Node 1:
startCluster.cmd 1

When the cluster environment is configured, you will get the message BUILD
SUCCESSFUL.

For Node 2:
startCluster.cmd 2
Enter the passphrase.

When the cluster environment is configured, you will get the message
Deployment to application server successful.

Change the administrative password

This upgrade changes the administrative password to the default password. After
the upgrade, change the password to minimize security risks. This password is the
admin password for logging in to the user interface.

Changing the network interface bindings (Windows)
About this task

To increase the security of the Administrator Console user interface, Sterling B2B
Integrator binds only to specific network interfaces. After the installation, if the
URL returns the error message Page cannot be displayed, you can adjust property
settings to correct the problem.

To update the property settings:

Procedure

1. On the server where Sterling B2B Integrator is located, edit the
noapp.properties_platform_ifcresources_ext.in file.

2. Locate the admin_host parameter.

Where hostnamel is the name of primary network interface, the one given
highest priority by Sterling B2B Integrator.

Where localhost is the name of the network interface on the server where
Sterling B2B Integrator is located.

admin_host.1 = hostnamel
admin_host.2 = localhost
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3. If no interface is being displayed, edit hostnamel so that it correctly identifies
the primary network interface that accesses Sterling B2B Integrator.

4. If an extra network interface must access Sterling B2B Integrator, add an
admin_host entry.

For example:
hostnamel

* admin_host.1

* admin_host.2 = Tocalhost

* admin_host.3 = hostname2

Stop Sterling B2B Integrator.

Navigate to \install_dir\install\bin.
Enter setupfiles.cmd.

© N o O

Restart Sterling B2B Integrator.

Disabling services
About this task

The upgrade process enables services that were disabled before the upgrade. If you
want to disable these services again, you must disable them in after the upgrade
process.

Download Sterling B2B Integrator Tools

Sterling B2B Integrator includes tools that run on a desktop or personal computer.
After you install Sterling B2B Integrator, you can install the following tools:

* Map Editor and associated standards
* Graphical Process Modeler (GPM)
* Web Template Designer

* (If licensed) MESA Developer Studio plug-ins, including, MESA Developer
Studio Software Development Kit (SDK) and MESA Developer Studio Skin
Editor

* (If licensed) Reporting Services, which requires MESA Developer Studio if you
want to use the plug-ins to create fact models and custom reports.

Conflicting IP addresses can cause problems when you download a desktop tool.

Enabling business processes
About this task

During the upgrade process, your customized business processes are preserved,
but they might not be the default business processes. Review the business
processes and enable the customized versions.

Property files configuration in a Windows environment

Property files contain properties that control the operation of Sterling B2B
Integrator. For example, the REINIT_DB property in the sandbox.cfg file controls
whether a database is initialized when you install Sterling B2B Integrator.

By modifying the values of these properties, you can customize the Sterling B2B

Integrator to suit your business and technical needs. Most property files are in the
\install_dir\install\properties directory.
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After you install Sterling B2B Integrator, most property files and scripts do not
need any further configuration for basic operation. However, if you want to
customize any specific operations, such as setting a different logging level, you
must edit (or in some cases, create) certain property or .xml files.

Before you change any property files, refer to the Working with Property Files
documentation for general information about how to work with Property Files.

Areas where you might make specific property files changes after an installation
include:

* LDAP user authentication

* Prevention of cross-site script vulnerabilities
* Logging configuration

* Process-specific property file settings

Adding cdinterop files
About this task

During the upgrade, the cdinteropt files were replaced. Copy the customized
version into the upgrade.

Adding third-party libraries
About this task

If you added third-party libraries to configure adapters for the previous release,
you must add each of the libraries again after you complete the upgrade. See the
documentation for each third-party adapter you use.

Reviewing the EDI sequence check queue
About this task

The EDI sequence check queue is used for X12 and EDIFACT sequence and
duplicate checking. You can check the contents of the queue through the UI
(Trading Partner > Document Envelopes > EDI Sequence Check Queue). Any
interchanges that are in the queue will not be able to be processed after upgrade
because the EDI compliance report serialized format changed.

If you installed the 5005 media or upgrade to 5005 and higher, the EDI Post
processor displays the following error:

The compliance report for interchange <interchange document ID> could not be
deserialized because the format has changed. The entry for this interchange
should be manually removed from the EDI Sequence Check Queue through the UI,
and the inbound deenvelope workflow should be rerun (WF ID <wfid>).

If you receive this error, follow the instructions in the error message to correct the
situation.

Configuring services and adapters
About this task

You might have to reconfigure services and adapters after an upgrade. During an
upgrade, packages for services and adapters are reprocessed to update the service
configurations.
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After an upgrade, the configurations of default adapters and services are reset to
their default configurations. The reset includes directory paths, which are restored
to their default paths. You must reconfigure those adapters and services, which
include, but are not limited to the following list:

+ All default FTP adapters

* All default SFTP adapters

* Connect:Enterprise UNIX Server adapter
* OdetteFTP adapter

* SAP Suite adapter

* SWIFTNet Client Service

* SWIFTNet Server adapter

If you modified the standard configuration for a service or adapter, you must
reconfigure or reactivate the service or adapter after an upgrade. You must
reconfigure adapters that used directories or scripts in the installation directory of
your previous release.

Examples of services and adapters that commonly must be reconfigured following
an upgrade:

* FTP adapter

+ System services such as the Alert service and the BP Fault Log adapter

The following adapters need special consideration after an upgrade:
* JDBC adapter and Lightweight JDBC adapter

* File system adapter and Command Line2 adapters

* Odette FTP adapter

Configuring the JDBC adapter and Lightweight JDBC adapter
About this task

Storage locations of the database pool properties that allow the JDBC adapter and
the Lightweight JDBC adapter to communicate with your external database were
streamlined. The poolManager.properties file was eliminated and some of its pool
properties are now included in the jdbc.properties file, along with some new
properties. You must manually update your existing jdbc_customer.properties.in
file to add some new database pool properties. If you do not have a
jdbc_customer.properties.in file, create one since customer.properties is not
affected by product updates.

Configuring the file system and Command Line2 adapters
About this task

You must configure your file system and Command Line2 adapters before you
remove the previous release directory. Reconfigure any file system and Command
Line2 adapters that were configured to use directories or scripts in the installation
directory for the previous release. Ensure that you create new directories and save
scripts outside of the current installation directory and edit each configuration to
use the appropriate directories and scripts.

Consider:

* If you are using the Command Line2 adapter and the CLA2C1ient.jar file is
located anywhere other than the default location, you must replace it with the
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new version. For information about the default location and how to start the
Command Line2 adapter, see the section Command Line2 adapter.

* If you are upgrading to this version of Sterling B2B Integrator from a version
lower than 4.0.1 and are using the Command Line2 adapter, you must update
the CLA2CTient. jar file with the version in the /install dir/install/client/
cmd1ine2 UNIX directory or in the \install_dir\install\client\cmdline2 for
Windows. If you installed the CLA2C1ient.jar file anywhere other than the
default location, you must replace each copy of the file with the new version. If
you only installed it in the default location, the update occurs automatically
during the upgrade process.

* If you are upgrading to this version of Sterling B2B Integrator from a version
before 4.0 and are using the Command Line adapter, you must update the
CLAClient.jar file with the version in the /install dir/install/client/
cmd1ine2 UNIX directory or in the \install_dir\install\client\cmdline2 for
Windows. If you installed the CLACTient. jar file anywhere other than the
default location, you must replace each copy of the file with the new version. If
you only installed it in the default location, the update occurs automatically
during the upgrade process.

The CLA instances are now pointing to the CLA2 Service definition. After you
import the old service instances of CLA onto Sterling B2B Integrator, you must
reconfigure the imported CLA services to reset the Remote Name and Remote Port
service configuration parameters. For more information, see the documentation for
the Command Line adapter and Command Line2 adapter.

Configuring the Odette FTP adapter

About this task

If you use the Odette FTP adapter and are using the Partner Profile XML file
version 2.00 that is used in Sterling Gentran Integration Suite 4.3, you must modify
it to match the new Partner Profile version 3.00. To modify the XML file, refer to
the following table:

Section Name of structure or field Action Comment
Partner Profiles <GeneralParameters> Use correct version label of the New Version
Partner Profile. label: 3.00

<PartnerProfileVersion>3.00

< /PartnerProfileVersion>

</GeneralParameters>
Physical Partner | Description Add field and description content Mandatory in
OFTP Partner
database
Physical Partner | SubMailbox Add field, if used. Optional
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Physical Partner

<AuthenticationCertificate

VA

type ="...">
<Subject>string</Subject>
<Issuer>string</Issuer>
<Serial> Bignumber_string
</Subject>

</ AuthenticationCertificate>

Add Structure, if used.

OFTP 2.0:
Mandatory for
security only.
Structure might be
repeated.

Physical Partner

<AuthenticationCertificate
type ="Private Key”>
<Subject>string</Subject>
<Issuer>string</Issuer>
<Serial>Bignumber_string
</Subject>

</AuthenticationCertificate>

Add Structure, if used.

OFTP 2.0:
Mandatory for
security only.

Physical Partner/
CAPI

DWindowSize

Delete field

Physical Partner/ |IPFilter Uses IPv4 or IPv6

P addresses.

Physical Partner SSL Add field, if used. OFTP 2.0:

r Mandatory for
security only.

Physical Partner CipherStrength Add field, if used. OFTP 2.0:

P Mandatory for
security only.

Physical Partner <SSLCertificate Add structure, if used. OFTP 2.0:

P Mandatory for

type ="..."> security, only.

<Subject>string</Subject>
<Issuer>string</Issuer>

<Serial> Bignumber_string

Structure might be
repeated.

</Subject>
</SSLCertificate>
Physical Partner | Description Add field and description content. Mandatory in
Contract OFTP Partner
database.
Physical Partner | MultipleLoginSessions Now used.

Contract

Physical Partner
Contract

DuplicateFilePeriod

Rename
DuplicateFileProcessingTestings

To DuplicateFilePeriod
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Physical Partner | SessionLogLevel Add fields. Optional

Contract

Physical Partner GroupNamelList Add fields, if used. Optional

Contract

Physical Partner | SecureAuthentication Add fields. OFTP 2.0:

Contract Mandatory

Physical Partner | <TimeScheduleTable> Delete structure and create schedules | Initiator Business

Contract in the Scheduler. Process and
Business Process

. user fields are still
<TimeScheduleTable> used.

Physical Partner | OdetteFTPAPILevel Rename OdetteAPILevel to

Contract OdetteFTPAPILevel

Logical Partner Description Add field and description content. Mandatory in

OFTP Partner
database.

Logical Partner

<FileServiceCertificate

type ="...”> <Subject>string</

Subject>
<Issuer>string</Issuer>
<Serial>string</Subject>

< /FileServiceCertificate>

Add structure, if used.

OFTP 2.0:
Mandatory for
security, only.
Structure might be
repeated.

Logical Partner
Contract

Description

Add field and description content.

Mandatory in
OFTP Partner
database.

Logical Partner
Contract

FileTransmissionRetries

Rename FileTransmitRetries to
FileTransmissionRetries

Logical Partner
Contract

SignedEERPRequest

Add field, if used.

Logical Partner
Contract

EERP/NERPSignatureCheck

Add field, if used.

Logical Partner
Contract

File Signing

Add field, if used.

Logical Partner
Contract

File Encryption

Add field, if used.

Logical Partner
Contract

CipherSuite

Add field, if used.

Logical Partner
Contract

File Compression

Add field, if used.

Logical Partner
Contract

CharEncoding

Add field, if used.

Logical Partner

Receive VitualFilenamePattern

Add field, if used.

Contract

Logical Partner EERPTimeout Rename WaitForEERP to
Contract EERPTimeout

Logical Partner FileScheduleTimeout Add field, if used.

Contract
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Logical Partner
Contract

InboundBusinessProcess Add field, if used. Optional

Logical Partner
Contract

InboundBusinessProcessUser Add field, if used. Optional, if no

Inbound business
process is
specified.

After you change the Partner Profile for version 3.00, import the Partner Profile
into the new Odette FTP Partner Profile database. For more information, see
Odette FTIP Partner Profile.

Restoring the performance tuning configuration

About this task
Before you begin this procedure, you must add the Advanced File Transfer Tab.
To restore the performance tuning configuration:

Procedure

1. From the Administration Menu, select Operations > System > Performance >
Tuning.

2. Next to Edit Performance Configuration, click Go!

3. Click Edit settings.

Adding the Advanced File Transfer tab

About this task

The Advanced File Transfer tab will not be enabled by default after an upgrade. If
you have a license for Advanced File Transfer, do the following steps to add the
Advanced File Transfer tab:

Procedure

Log in as Admin.

Click Manage Layout.

Click Add Pane.

Enter the following name: Advanced File Transfer

Click Apply.

Click the customize icon for the new Advanced File Transfer tab.
Click Add Portlet.

Select the Add box for Advanced File Transfer Management.
Click Apply.

Select Clear Borders and Title from the Decoration menu.

SO 0N oAb
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Click Save and Apply.

Reconfiguring archive settings

About this task

The upgrade does not automatically reconfigure the archive configuration. You
must reconfigure the Backup Directory setting in archive manager after an
upgrade.
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To reconfigure your archive settings, use the following procedure:

Procedure

From the Administration Menu, select Operations > Archive Manager.
Next to Configure Archive Settings, click Go!

If a message displays about the UI Lock, click OK to continue.

Click Next.

Update the Backup Directory field with the correct path information:
Click Save.

Confirm the settings and click Finish.

N O~

Correcting missing manager IDs
About this task

If you created a manager ID with no corresponding user ID in your previous
version, the Manager ID might be missing after the upgrade. If the ID is missing,
create a user in the system with a user ID that matches the missing manager ID.

Configuring document file systems
About this task

If you use a file system as your document storage method, determine and record
the path to the file system.

You must have the file system path structure so that after the upgrade, you can
copy/mount the documents to the new installation directory. The directory
structure (path to the file system) must be the same in the current and in the
upgraded system.

Updating the database (dbupdate) with the startCluster
command
About this task

The startCluster.sh nodeNumber command on node 1 automatically updates the
database, unless you use the command startCluster.sh 1 false. The
startCluster.sh nodeNumber command on all other nodes does not update the
database.

When you configure Sterling B2B Integrator cluster for the first time, run the
startCluster.sh command with the database update value set to true
(startCluster.sh 1 true). Running this command enables all cluster-related
configurations. The database update synchronizes the scheduled jobs between the
nodes by assigning them all to node 1.

The startCluster.sh command with the database update value turned off
(startCluster.sh 1 false) prevents any configuration changes from affecting the
system, especially after you install fix packs or interim fixes.

For current database updates, the following services are tied to node 1:
* Schedule

* FileSystem

¢ CmdLine
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CDServerAdapter

CDAdapter

CDRequesterAdapter
CEUServerAdapter

HttpServerAdapter
B2B_HTTP_COMMUNICATIONS_ADAPTER
HTTP_COMMUNICATIONS_ADAPTER
HTTPClientAdapter

FTPClientAdapter

FtpServerAdapter

SFTPClientAdapter

The following services have storage that is set to the database:

HttpServerAdapter

CEUServerExtractServiceType
CDSERVER_ADAPTER

The default storage of all workflows is set to the database.

Manage Nodes in a Cluster
About this task

You can add or remove nodes in a cluster environment. The following
prerequisites should be considered before performing any modification in the
cluster environment:

New nodes should have the same range of ports available as the current nodes.

Sterling B2B Integrator license file should be updated to include the IP address
of the new nodes.

Directory structure on the new nodes should match with the directory structure
of the existing nodes.

Perimeter servers should be updated with the new IP addresses to ensure proper
configuration.

Any adapters, services, or business processes assigned to or scheduled to run on
the node being removed should be assigned to run on other nodes.

Add a Node to the Cluster (Windows)
About this task

You do not need to stop the cluster environment while adding a new node.

To add a node into the cluster:

Procedure

1.

Install a new Sterling B2B Integrator node to be added into the cluster with the
—cluster option during installation. Refer to the Upgrade the Cluster using
GUI-Based Method in Windows. Ensure that the new node being added is not a
primary node.

Update jgroups_cluster.properties file and jgroups_cluster.properties.in file with
the new node details.
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3. Configure the new node by running the startcluster.cmd nodeNumber from the
\install_dir\install\bin directory. The node number should be greater than 1.

You should run startCluster.cmd command only after you install Sterling B2B
Integrator. You should not run startCluster.cmd command when you restart a
Sterling B2B Integrator instance.

4. Start the new node.

Remove a Node from the Cluster
About this task

To remove a node from the cluster:

Procedure

1. Reassign or stop any adapters, services, or business processes assigned to or
scheduled to run on the node being removed.

2. Perform backup of the node being removed.

3. Edit jgroups_cluster.properties file and jgroups_cluster.properties.in file in all
nodes to remove the IP address of the node being removed.

4. Restart the cluster environment.

JMS cluster configuration for failover

To allow correct JMS execution and failover in the Sterling B2B Integrator cluster
environment, you must configure an external ActiveMQ by following the steps that
are outlined in theConfigure ActiveMQ for a cluster environment task.

The following diagram illustrates how the ActiveMQ can be configured to increase
availability and failover.
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Configure ActiveMQ for a Cluster Environment (Windows)
About this task

To configure ActiveMQ for the windows cluster environment:

Procedure

1. Download the ActiveMQ 5.2 from http://activemq.apache.org/activemq-520-
release.html for the appropriate OS.

2. Deploy an instance of ActiveMQ 5.2. This can be on the same machine as
Sterling B2B Integrator or on a separate machine.

3. Navigate to \install_dir\install\properties using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.
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4. Copy the activemq.xml file to the AMQ conf directory. This file configures the
ActiveMQ to:

* Use failover clustering,

* Use the SI database for storage

* Configures the AMQ port usage

By default, ActiveMQ is configured to listen at the Sterling B2B Integrator base
port + 64 and the ActiveMQ interface will be at base port + 65

(http://server:base port + 66/admin). The port can be changed by editing the
config file directly.

5. Navigate to \install_dir\install\ properties using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

6. On each Sterling B2B Integrator node and each Sterling B2B Integrator
container node, the queue configuration must be re-directed to utilize the
ActiveMQ cluster. In each node, add the following to the
customer_overrides.properties:

For FIFO Processing:

fifo.broker.username=

fifo.broker.password=
fifo.broker.url=failover:(tcp://amq_master_hostname:amq_master_port,
tcp://amg_slave_hostname:amq_slave_port)

For adapters running in separate JVM containers:

iwfcqueue.username=

iwfcqueue.password=

jwfcqueue.protocol_config=failover: (tcp://amg_master_hostname:amq_master_port,
tcp://amg_slave _hostname:amq_slave port)

7. Start the ActiveMQ instances. To start ActiveMQ), it is necessary to supply the
activemgq.hostname property with the hostname for the current system. For
example:

activemq.bat -Dactivemq.hostname=ExampleHostname

See http:/ /activemgq.org for additional information about running an ActiveMQ
instance.

8. Start Sterling B2B Integrator.

Configure Shared File Systems as Document Storage
(Windows Cluster)
About this task

To configure the shared file systems as document storage:

Procedure

1. Navigate to \install_dir\install\properties for the node using one of the
following methods:
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For Windows Server 2003 or earlier For Windows Server 2008

Open a command prompt window (from the | Complete the following steps:
Run dialog box). * Click Start.

Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

* Right-click Command Prompt and select

2. Open the jdbc.properties.in file.

3. Update the value of the document_dir attribute to point to the shared files
system directory where you store documents.

4. Save and close the file.

5. Navigate to \install_dir\install\bin using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008

Open a command prompt window (from the | Complete the following steps:
Run dialog box). + Click Start.

Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

* Right-click Command Prompt and select

6.
7.

Enter setupfiles.cmd.
Restart Sterling B2B Integrator.

Adding host[port] from all the nodes to the
jgroups_cluster.property.in for each node
About this task

Complete this task for both vertical and horizontal clusters. You must complete

this task for each node, starting with node 1.

Before you begin, it is important that you never override mcast_addr in the
jgroup_cluster.properties file.

To add the host [port] to the jgroups_cluster.property.in file:

Procedure

1.
2.

Navigate to the properties file directory for the node.
Determine the initial_hosts port for each node:
* Navigate to the properties file directory for the node.

* Find the initial_hosts from the jgroups_cluster.property
(initial_hosts=host{port}).

* Record the value from the initial_hosts for each node.
Open the jgroups_cluster.property.in file.
Add the initial_hosts property to the file.

For example, if node 1 is on hostl and node 2 is on host2. For node 1, you
would add:

initial_hosts=hostl[portl],host2[port2]
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For node 2, you would add:
initial_hosts=host2[port2],hostl[portl]
5. Save and close the file.

Configuring JVM containers
About this task

After you upgrade the system, you must reconfigure the JVM containers.

Before you reconfigure the JVM containers, you must know the container numbers
from the previous installation.

For example, if you configured the container with the command,
setupContainer.sh (or cmd) 1, then the container number is 1.

Use one of the following tasks to reconfigure your containers:
* Setting up an adapter Container - iSeries

e Setting up an adapter Container - UNIX/Linux

* Setting up an adapter Container - Windows

System Maintenance

Cluster Maintenance Overview

From time to time, you may need to perform system maintenance activities. These
activities might include any or all of the following:

* Applying a Patch

* Applying a Hot-fix

* Performing a Checksum

* Generating a Patch Change Report
* Adding or Removing a License

Patch or interim fix in a Windows Cluster Environment

Sometimes, you will need to apply either a patch or an interim fix to your Sterling
B2B Integrator installation:

* All nodes in the cluster must be patched to the same level. You must stop all
nodes in the cluster before installing a patch, then install the patch on each
node. Attempting to apply a patch while part of the cluster is running should
only be done with the advice of IBM Customer Support.

* Patches contain cumulative fixes for a specific version of Sterling B2B Integrator.
Because each patch contains the fixes from previous patches, you only need to
install the most recent patch. You should periodically check the web site to
verify that you have the most recent patch.

* An interim fix (iFix) is one or more fixes applied to a specific existing patch.

It is possible to apply patches to nodes while other nodes are processing. However
a patch containing any of the following, requires the entire cluster to be down:

* Critical cluster functionality
* Engine-related changes
* Changes to the database
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You can preserve your custom changes to system resources (like workflow
definitions and maps) when you update your system. During updates, the system
can identify when you make a custom change versus when the system makes a
change through an upgrade or patch.

When a patch, installation or upgrade is performed, a baseline record of system
resources is created. This baseline is not affected by any subsequent customer
changes. When another patch is installed, the resources in this baseline are
compared to the resources in the existing system. If a baseline and existing
resource are not the same, it means that the existing resource was customized and
is not overwritten by the patch.

During an update, the baseline is updated with new system resource information,
but not with custom changes to resources.

Determining whether you must apply a fix pack (Windows)
About this task

Fix packs contain cumulative fixes for a specific version of Sterling B2B Integrator.
Fix pack files are available on the Support Center website. Because each fix pack
contains the fixes from previous fix packs, you are only required to install the most
recent fix pack.

Note: During fix pack installation, the dbVerify utility compares the list of
standard indexes with the indexes present in the database and drops the custom
indexes. Re-create the custom indexes after the fix pack installation is complete.

Fix pack files are named with the following naming convention:
si_<release number>_build_<build number>.jar

Information about a fix pack is in a PDF file with a similar name. PDF files that
contain information about a particular fix pack use the following naming
convention:

si_<release number> build <build number> patch_info.pdf

Before you install the fix pack, review the following items:
* Preserve your custom changes to system resources.

* The fix pack installation might use one or more patch property override files.
These files are named propertyfile fixPack.properties. Do not alter these files.

* Property changes made directly in the *.properties or *.properties.in files
might be overwritten during the fix pack installation. Properties that are
overridden with the customer_overrides.properties file are not affected.
Maintain property file changes with, when possible, the
customer_overrides.properties file. For more information, see the property file
documentation.

* If you edited any of the cdinterop files, you must back them up before you
apply the fix pack. The cdinterop files do not have initialization (*.in) files. After
you apply the fix pack, use the backup version of the files in your patched
installation. These files include the following files: cdinterop-proxy-
records.properties; cdinterop-spoe-auth.properties; cdinterop-spoe-
policy.properties; and cdinterop-user-records.properties.

* Information about the fix pack installation is automatically logged to
\install _dir\install\logs\InstallService.log.
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* If you must roll back a fix pack, see the Patch change report.

Preserving custom changes in a Windows cluster environment
About this task

As part of a default cluster configuration, certain values in the database for service
or adapter configurations, and default document storage, must be updated to get
the cluster working. The default settings do not include a shared or mounted file
system with a line of sight from all cluster nodes. Certain service or adapter
configurations are forcibly deployed on node 1 and the default document storage
type is set up to "Database" for all business processes.

To keep these custom configuration changes from being overwritten, you can run
the following cluster configuration script:

startCluster.cmd nodeNumber true/false

Where:

* nodeNumber is the cluster node number
* True runs database updates

* False prevents database updates.

The first time that you configure a cluster, you must set the option to true. After
the first configuration, you can use the false option. The false option prevents any
configuration changes from affecting the system, especially after installation of a fix
pack or interim fix.

Installing a Critical Maintenance Patch to the Cluster (Windows)
About this task

To install a critical patch to the entire cluster in a Windows environment (where
you need to stop the entire cluster):

Procedure
1. Navigate to Support Center website.

2. Download the most recent patch file for your version of Sterling B2B
Integrator and record the absolute path to the downloaded file. Do not
rename the file. If you use FTP, you must use Binary mode.

3. Verify that the database server is up and ready to accept connections.
4. Stop all the nodes in the cluster.

5. Perform a full backup of the Sterling B2B Integrator installation directory,
including all subdirectories.

6. Perform a backup of the database.

7. If you edited any property files, ensure that the associated properties.in files
have the most current changes. Property files will be overwritten with the
contents of the associated properties.in files during the patch installation.

8. Is the database password encrypted? If Yes, decrypt the password.
9. Close all command prompt windows.

10. Navigate to install_dir for the node (starting with node 1), using one of the
following methods:
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For Windows Server 2003 or earlier For Windows Server 2008

Open a command prompt window (from the | Complete the following steps:
Run dialog box). « Click Start.

Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

11. Enter: InstallService.cmd path\
si_version_sp_0_patch_number_app_server.jar
where:

path is the fully qualified path to maintenance patch file

version is the Sterling B2B Integrator version

number is the patch number

app_server is the application server
If the patch attempts to modify the database schema and the modification
fails, you will receive an error message about the failure. The message will
provide the error message code from the database and the SQL command that
failed. The failure information is also logged to the system.log file (in the
\install_dir\install directory) and to the patch.log file.
Attention: Running InstallService.cmd removes any previously installed
interim fix to prevent conflicts with what is being installed.

12. Press Enter to continue.

13. If you want to accept the license agreement, enter VY.

14. Enter the passphrase.

Information about the patch is displayed. After the patch has been applied,
the following message is displayed:
Deployment to application server successful.

15. After you have completed the patch for node 1, you can now perform the
steps for node 2 and greater. For node 2 and greater, you must update the
value of REINIT_DB to false. When REINIT_DB is false, database updates are
not applied during each patch. The REINIT_DB attribute is in the
\install_dir\install\properties\ sandbox.cfg file.

16. Repeat Steps 10 to 14 to apply the patch to each node.

17. If you decrypted the database password, re-encrypt the password.

18. For each node, navigate to the install_dir and start the nodes, using one of the
following methods:

For Windows Server 2003 or earlier For Windows Server 2008

* Open a command prompt window (from Complete the following steps:

the Run dialog box). * Click Start.

* Enter startCluster.cmd nodeNumber. * Right-click Command Prompt and select

Run as administrator.
The Administrator: Command Prompt
dialog box is displayed.

* Enter startCluster.cmd nodeNumber.

19.

Restart Sterling B2B Integrator.
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If you are using a perimeter server in the DMZ, you will to review the
information on apply a patch to the perimeter server.

Installing a Maintenance Patch One Node at Time to the Cluster
(Windows)
About this task

To install a patch to the one node at a time in a Windows Cluster environment,
starting with node 1:

Procedure

1. Navigate to Support Center web site.

2. Download the most recent patch file for your version of Sterling B2B
Integrator and record the absolute path to the downloaded file. Do not
rename the file. If you use FTP, you must use Binary mode.

3. Verify that the database server is up and ready to accept connections.

4. Navigate to \install_dir\install\bin using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008

Open a command prompt window (from the | Complete the following steps:
Run dialog box). * Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

5. Enter StopWindowsService.cmd to stop the node. Wait until the perimeter
server of the node is completely down before installing the patch.

6. Perform a full backup of the Sterling B2B Integrator installation directory,
including all subdirectories.

7. Perform a back up of the database.

8. If you edited any property files, ensure that the associated properties.in files
have the most current changes. Property files will be overwritten with the
contents of the associated properties.in files during the patch installation.

9. Is the database password encrypted? If Yes, decrypt the password.

10. Close all command prompt windows.
11. Navigate to the installation directory, using one of the following methods:
For Windows Server 2003 or earlier For Windows Server 2008

Open a command prompt window (from the | Complete the following steps:
Run dialog box). + Click Start.

Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

12.

Enter: InstallService.cmd path\
si_version_sp_0_patch_number_app_server.jar

where:

path is the fully qualified path to maintenance patch file
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version is the Sterling B2B Integrator version
number is the patch number
app_server is the application server

If the patch attempts to modify the database schema and the modification
fails, you will receive an error message about the failure. The message will
provide the error message code from the database and the SQL command that
failed. The failure information is also logged to the system.log file (in the
install_dir\install directory) and to the patch.log file.

Attention: Running InstallService.cmd removes any previously installed
interim fix to prevent conflicts with what is being installed.

13. Press Enter to continue.
14. If you want to accept the license agreement, enter Y.
15. Enter the passphrase.

Information about the patch is displayed. After the patch has been applied,
the following message is displayed:

Deployment to application server successful.

16. After you have completed the patch for node 1, you can now perform the
steps for node 2 and greater. For node 2 and greater, you must update the
value of REINIT_DB to false. When REINIT_DB is false, database updates are
not applied during each patch. The REINIT_DB attribute is in the
\install_dir\install\properties\ sandbox.cfg file.

17. Repeat Steps 11 to 15 for each node.
18. If you decrypted the database password, re-encrypt the password.
19. Start Sterling B2B Integrator.

If you are using a perimeter server in the DMZ, you will to review the
information on apply a patch to the perimeter server.

Installing an interim fix (Windows Cluster)
After you install Sterling B2B Integrator you may need to install an interim fix
(formerly called hot-fix).

About this task
An interim fix is one or more fixes applied to a specific existing patch.

Before you can install an interim fix developed for your company, you must have
completed the following:

* Received the file name of the ccaseid.jar to install from IBM Customer Support
* Created a full backup of Sterling B2B Integrator
* Created a full backup of your database

* Preserve your custom changes to system resources.
To install an interim fix in a Windows Cluster environment, starting with node 1:

Procedure
1. Log in to the computer that you are installing the interim fix on.
2. If the database password was encrypted, decrypt the password.
3. Navigate to the IBM Fix Central website.
4

. Login using your email address and password.
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5. Download the ccaseid. jar file, where ccaseid includes the ID number you
received from Customer Support. If you use FTP, you must use Binary mode.

6. Stop Sterling B2B Integrator.

7. Navigate to install_dir for the node (starting with node 1), using one of the
following methods:

For Windows Server 2003 or earlier For Windows Server 2008

Open a command prompt window (from the | Complete the following steps:
Run dialog box). * Click Start.

Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

8. Enter InstallService.cmd \absolutePath\ccaseid.jar to install the interim
fix.
You may need to complete this step twice depending on the patch. Read the
output from the InstallService script carefully to see if you need to complete
this step twice.

Attention: Running InstallService.cmd removes any previously installed
interim fix to prevent conflicts with what is being installed.

9. After you have installed the interim fix for node 1, you can now perform the
steps for node 2 and greater. For node 2 and greater, you must update the
value of REINIT_DB to false. When REINIT_DB is false, database updates are
not applied during each patch. The REINIT_DB attribute is in the
\install _dir\install\properties\ sandbox.cfg file.

10. Repeat Steps 7 and 8 for each node.
11. If you decrypted the database password, re-encrypt the password.

12. For each node, navigate to the install_dir (starting with node 1) and start the
cluster, using one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008

* Open a command prompt window (from
the Run dialog box).

¢ Enter startCluster.cmd nodeNumber

Complete the following steps:

¢ Click Start.
Right-click Command Prompt and select
Run as administrator.
The Administrator: Command Prompt
dialog box is displayed.

* Enter startCluster.cmd nodeNumber

13. Start Sterling B2B Integrator.

14. Navigate to the install_dir\install\bin directory, run the dump_info
command to verify that the interim fix was successfully installed, using one of
the following methods:
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For Windows Server 2003 or earlier For Windows Server 2008

* Open a command prompt window (from . )
the Run dialog box). Complete the following steps:

¢ (lick Start.

* Enter dump_info.cmd

Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

* Enter dump_info.cmd

Uninstalling an interim fix
Uninstalling an interim fix is a manual process. IBM support must first determine
what is included in the interim fix you want to remove, and then manually

backout the changes one at a time. The complexity of this process, therefore, can
vary greatly.

If you must remove an interim fix, contact IBM support by creating a PMR
(Problem Management Record)

DB checksum tool

A checksum is a simple redundancy check used to detect errors in data. In Sterling
B2B Integrator, a verification process is used to compare the checksum between the
existing default resource and the resource that was added after application of a fix
pack or upgrade. The DB checksum tool generates a granular report of the changes
in the system that could not be set as defaults.

The DB checksum tool generates the difference in resource checksum between the
default resource and the latest system resource from the database.

Perform a checksum (Windows)
About this task

To run the DB Checksum tool in the Windows environment:

Procedure
1. Navigate to \install_dir\bin with one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008

Open a command prompt window (from the | Complete the following steps:
Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. Enter db_checksum tool.cmd [-d] [-i [1 | 2 | 3| 4 | 51] [-r [wfd | map
| schema | sii | template]] [-o <output file>] [-g]
Where:

-d is the mode to dump the difference of resource checksum between the
default resource and latest system resource.

-i is the resource type integer.
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1is WED.

2 is MAP.

3 is SCHEMA.

4 is SIL

5 is TEMPLATE.

-r is the resource name. For example, wfd, map, schema, sii, or template.
-0 is the file name to output all the messages.

-g is the file name that lists all the ignored resources.

-h is the help screen.

The DB Checksum tool runs the relevant checksum operation that is based on

the command options that are used and generates the output message.

Patch changes report

The patch changes report is used to obtain information if you must roll back a fix

pack. The patch changes report can be found in the installation directory
patch_reports folder. The report contains the following fix pack information:

Fix pack ID

Fix pack changes

Number of files deleted

Number of JARs removed

Number of JARs added

Number of files added

Number of files changed

Number of properties added
Number of business processes added
Number of service instances added
Number of service definitions added
Number of templates added
Number of reports added

Number of maps added

Number of schemas added

Number of business rules added

For example, the installation directory patch_reports folder contains the file
Patch_Report.html. When you open this html file, you can view the patch
information.

Example: patch changes report
The following is an example of a patch changes report.

Summary of Changes

Patch ID: Platform_2.0

Patch Changes: 1287

Number of Files Deleted: 0

Number of JARs Removed: 2

Number of JARs Added: 0

Number of Files Added: 3

Number of Files Changed: 3

Number of Properties Added: 4

Number of BPs Added: 4

Number of Service Instances Added: 2
Number of Service Definitions Added: 3
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Number of Templates Added: 0
Number of Reports Added: 0

Number of Maps Added: 3

Number of Schemas Added: 3

Number of Business Rules Added: 0

List of JARs Removed:

JAR Removed: /SAMPLE_INSTALL 1/jar/jaf/1 0 2/activation.jar

Time: Wed May 13 15:23:08 EDT 2009

JAR Removed: /SAMPLE_INSTALL 1/jar/commons logging/1 0 3/commons-logging-api.jar
Time: Wed May 13 15:23:08 EDT 2009

List of Files Added:

File Added: /SAMPLE_INSTALL_1/bin/sql/fix_db2_schema.sql

Time: Wed May 13 15:21:30 EDT 2009

File Added: /SAMPLE_INSTALL_1/bin/sql/fix_db2iseries_schema.sql
Time: Wed May 13 15:21:30 EDT 2009

File Added: /SAMPLE_INSTALL_1/bin/errorQueueManager.sh.in

Time: Wed May 13 15:21:30 EDT 2009

List of Files Changed:

File Changed: /SAMPLE_INSTALL 1/properties/lang/en/Reports_en.properties
File Changed: /SAMPLE_INSTALL 1/properties/lang/es/Reports_es.properties
File Changed: /SAMPLE INSTALL 1/properties/lang/fr/Reports_fr.properties

List of Properties Added:

Property Added: /SAMPLE_INSTALL 1/properties/filesToRemove.txt
Property Added: /SAMPLE_INSTALL_ 1/properties/filesToRemove.txt.in
Property Added: /SAMPLE_INSTALL 1/properties/csr.properties.sample
Property Added: /SAMPLE_INSTALL_1/properties/csr.properties.sample.in

List of BPs Added:

BP Added: Schedule_AssociateBPsToDocs.bpml version: 4
Time: Wed May 13 15:23:07 EDT 2009

BP Added: Recovery.bpml version: 17

Time: Wed May 13 15:23:07 EDT 2009

BP Added: Schedule_AutoTerminateService.bpml version: 10
Time: Wed May 13 15:23:07 EDT 2009

BP Added: Schedule_DBMonitorService.bpml version: 1
Time: Wed May 13 15:23:08 EDT 2009

List of Service Instances Added:

Service Instance Added: RetentionProcessor version: 2
Time: Wed May 13 15:23:28 EDT 2009

Service Instance Added: MESAHttpServerAdapter version: 1
Time: Wed May 13 15:25:11 EDT 2009

List of Service Definitions Added:

Service Definition Added: LockServiceType
Time: Wed May 13 15:22:58 EDT 2009

Service Definition Added: XAPIServiceType
Time: Wed May 13 15:22:59 EDT 2009

Service Definition Added: CleanLockServiceType
Time: Wed May 13 15:22:59 EDT 2009

List of Templates Added:

Template Added: Normalize

Time: Wed May 13 15:23:26 EDT 2009
Template Added: Derive

Time: Wed May 13 15:23:26 EDT 2009

List of Maps Added:

Map Added: IBMPutResponseToXML
Time: Wed May 13 15:24:05 EDT 2009
Map Added: http_headers

Time: Wed May 13 15:24:36 EDT 2009
Map Added: OracleHttpHeaders
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Time: Wed May 13 15:24:51 EDT 2009

List of Schemas Added:

Schema Added: E5_V20_Acknowledge Result.dtd from file: E5_V20_Acknowledge_ Result
Time: Wed May 13 15:24:36 EDT 2009

Schema Added: E5_V20_Acknowledge_Submit.dtd from file: E5_V20_Acknowledge_ Submit
Time: Wed May 13 15:24:36 EDT 2009

Schema Added: E5 V20 APIs Result.dtd from file: E5 V20 APIs Result

Time: Wed May 13 15:24:36 EDT 2009

License modification

If after the installation is finished, you must modify the software licenses you
loaded, you can do that by using the AddLicenseSet command. The AddLicenseSet
command is in the bin directory of your UNIX or Windows installation. After the
initial installation, the license files are at:

e UNIX: /install dir/install/properties/Ticensefiles
* Windows: \install dir\install\properties\licensefiles
* iSeries: /install _dir/properties/licensefiles

You can add licenses or review the license list from the Ul Go to the
Administration Menu > System >B2B Console > Operations > System >
Licenses.

AddLicenseSet command parameters

The AddLicenseSet command can modify a single license file or the entire license
file directory.

To use the AddLicenseSet command:
* Navigate to the bin directory
* Include the absolute path to the license file directory or to a license file

The AddLicenseSet command has the following parameters:

AddLicenseSet Parameters |Description

-reload Use this parameter to reload the license files.

This parameter deletes all of the license files from the
database before the new files are loaded. The old license files
are saved to the following location:

* UNIX: /install_dir/instal1/logs/security/old_Ticenses

* Windows: \install_dir\install\logs\security\
old_licenses

* iSeries: /install_dir/logs/security/old_licenses

-upgrade Use this parameter during an upgrade only.

This parameter deletes all of the old license files from the
database and installs the new license files. The old license
files are saved to the following location:

* UNIX: /install _dir/install/logs/security/upgrade
* Windows: \install_dir\install\logs\security\upgrade

* iSeries: /install_dir/logs/security/old_licenses
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User Documentation

Sterling B2B Integrator user documentation

The user documentation is available on the online documentation site on the web.
Providing the documentation in an online environment allows for frequent updates
of content that is based on user feedback and usability.

We also understand the need for a printed copy of documentation. You can print
topics of information with your Internet browser, or you can download documents
in PDF format. You can also request a documentation CD.

To access the documentation site from within Sterling B2B Integrator or one of its

tools, select the Help @ icon. For the link to the documentation site to work, the
system must support internet access and an internet browser.

Online documentation tips
About this task

After you are in the documentation library, you can do the following things:
* Enter a word or phrase and search the entire library for information.

* Move through a hierarchy of contents pages to identify the topic you want to
read or print.

* Print topics by using your browser's Print function.
* Download entire documents in PDF format.

Requesting a documentation CD
About this task

You can request a CD that contains all the documentation found on the
documentation site. To submit a request, open a support case.

Uninstall the Software

Uninstalling Sterling B2B Integrator from a Windows cluster
environment
About this task

When you uninstall Sterling B2B Integrator, Sterling B2B Integrator is automatically
removed from the server.

Additionally, you can do the following tasks:
* Manually remove the JDK that was installed
* Manually remove any desktop tools that were downloaded

* Free any database space in Oracle, Microsoft SQL Server, or DB2 databases

To uninstall Sterling B2B Integrator from a Windows environment, do the
following steps for each node:
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Procedure
1. Navigate to \install_dir\install\bin with one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

2. Enter StopWindowsService.cmd. Wait for the shutdown to complete. If you begin
removing files before all business processes and the system are stopped, you
might be unable to remove Sterling B2B Integrator successfully.

3. Optional: Back up the file system and database.

By backing up the file system and database, you ensure that Sterling B2B
Integrator is recoverable.

4. Remove the installation directory by entering the following command in the
parent directory of your installation directory: rm -rf install_dir

5. If you use an Oracle, Microsoft SQL Server, or DB2 database, the database
remain intact even after you remove Sterling B2B Integrator from the server. If
you no longer want to reference the data, contact your database administrator
about removing unwanted tables and recovering the database space where
Sterling B2B Integrator used to be located.

6. Navigate into the _uninst subdirectory of your JDK installation directory with
one of the following methods:

For Windows Server 2003 or earlier For Windows Server 2008

Open a command prompt window (from the | Complete the following steps:

Run dialog box). « Click Start.

* Right-click Command Prompt and select
Run as administrator.

The Administrator: Command Prompt
dialog box is displayed.

7. To manually remove the JDK, enter uninstall.cmd.

8. After you remove Sterling B2B Integrator from the server, you can remove
Eclipse, and any tools that were downloaded to the desktop:

* Map Editor and associated standards

Refer to the Map Editor Guide for information about removing the Map
Editor.

* Graphical Process Modeler

Refer to the Graphical Process Modeler Guide for information about removing
the Graphical Process Modeler.

* Web Template Designer

Refer to the Web Extensions Guide for information about removing the Web
Template Designer.

* (If licensed) MESA Developer Studio plug-ins:
— MESA Developer Studio Software Development Kit (SDK)
— MESA Developer Studio Skin Editor
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Refer to the MESA Developer Studio guide for information about removing

MESA Developer Studio.

* (If licensed) Reporting Services, which require MESA Developer Studio if you
want to use the plug-ins to create fact models and custom reports. Refer to
the MESA Developer Studio guide for information about removing Reporting

Services.

Troubleshooting Tips for Windows

Troubleshooting tips for Windows environment

Situation

Message or Symptom

Explanation/Resolution

Installing

You encounter errors or problems during
installation.

Explanation

The installation creates several log files that you
can use to diagnose problems like the failure of
an installation.

Resolution

Examine the log files that are generated during
installation:

* ant.install.log (in the install_dir directory)
* install _dir\PreInstallSI.log

Installing

When you entered an absolute path during
installation, a message indicated that the
command was not found.

Explanation

You entered an incorrect path. Check the
information that you entered.

Resolution

Enter the correct path.

Installing a
desktop tool or
resource

Cannot download any of the following;:

* Map Editor and associated standards

* Graphical Process Modeler

* Web Template Designer

* (If licensed) MESA Developer Studio plug-ins:

— MESA Developer Studio Software
Development Kit (SDK)

— MESA Developer Studio Skin Editor

* (If licensed) Reporting Services, which require
MESA Developer Studio if you want to use
the plug-ins to create fact models and custom
reports.

Explanation

When you install Sterling B2B Integrator, system
files are created that contain an internal IP
address. If you install Sterling B2B Integrator
behind a firewall, and your firewall is
configured to accept an external IP address from
a client computer, you might not be able to
download the desktop tools and resources. The
firewall rejects the internal IP address from a
client that is located outside of the firewall.

Resolution

Modify the system files that contain the invalid
IP address. Follow these steps:

1. Navigate to \install_dir\install\bin.
2. Stop Sterling B2B Integrator.

3. Enter the following command followed by
the external IP address:

patchJNLP.cmd external _IP_address
4. Restart Sterling B2B Integrator.
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Situation Message or Symptom Explanation/Resolution
Cluster When you configure TCPS the following Resolution
Installation or | warning can be found in the
Upgrade activemgbroker.1og: Add the system certificate to the truststore with
the KeyTool command.
sun.security.provider.certpath.
SunCertPathBuilderException:
unable to find valid certification
path to requested target
Cluster When you configure TCPS the following Resolution
Installation or | warning can be found in the
Upgrade activemgbroker.log: Do not mention any SSL cipher in the
ActiveMQconfig.xml.
Do not mention any
SSL cipher in the ActiveMQconfig.
xml. oracle.net.ns.NetException:
Invalid cipher suites specified.
e-Invoice When you upgrade Sterling e-Invoicing and are | Resolution
Upgrade: using an Oracle database, if the upgrade fails . . )
Oracle Add with the error message name is already used If you receive this error message, the solution

Constraint Error

by an existing object, the error occurs because
the default behavior for the drop constraint
command was changed in Oracle 10. The index
that is used to support the constraint is now
only removed if the index was generated by the
create constraint command. The indexes for
Sterling e-Invoicing are always generated from
constraints during an installation.If you receive
this error during a Sterling e-Invoicing upgrade,
it is because of how the database was restored,
the version of Oracle you are using, and because
the Oracle imp command exported the indexes
and constraints separately. There is no way to
determine when the imp command does not
add a create index command to the export file if
it was generated by a constraint — but if it does
add the command, the database restore process
loses the association of the constraint and its
underlying index. The database script that runs
during a Sterling e-Invoicing upgrade runs two
steps: 1. First, it drops the unique constraint so
the next step can redefine it using extra
columns. However, the drop constraint
command does not remove the underlying
index if the association with its index was lost.
2. The next command that redefines this
constraint requires a different index definition,
but in this scenario the name of the index the
constraint wants to use exists, which causes the
name is already used by an existing object
error.

for this problem is to drop the index and rerun
the Sterling e-Invoicing upgrade. The drop
index command to use is: drop index
UNQ_EINV_CANON
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
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incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
J46A/G4

555 Bailey Avenue

San Jose, CA 95141-1003
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
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This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2015. Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. 2015.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at ’1Copyright andl
[frademark information!” at |http:/ /www.ibm.com /legal / copytrade.shtml[

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise®, Gentran®,
Gentran®:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce ",
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce®, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.
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